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How MyAssistant Works 
MyAssistant monitors for specific situations based on your information in Sage and 

automatically informs someone. This can be as simple as sending someone a list of Jobs that 

haven't been billed in a number of days, or an AR aging spreadsheet to the people who need 

to know. MyAssistant automatically provides information to the people who need it to help 

run the business. 

 

MyAssistant uses automated processes called "Tasks" to monitor specific information in Sage 

and notify someone via email. Tasks tell the software what to look for, who to email and 

what you want to send them. 

 

Running Tasks is made up of the following processes:  

1. A Task runs (either by a Schedule or being manually triggered by a user) 

2. MyAssistant looks up specific information in Sage that meets the criteria specified in 

the Task's Condition.  

 

Example: A Task can look for Vendors with Expiring insurance 

 

3. When the specified information is found, MyAssistant determines if emails need to be 

sent and creates as many messages as needed (based on the Recipients). Specific 

email addresses can be entered on the Task, or MyAssistant can look up who to 

notify based on what was found.  

 

Example: MyAssistant can look up an email addresses for Vendors with expiring 

insurance and create a separate email for each one 

 

4. Emails and any attachments are created by pulling information from Sage, including: 

▪ Lists & form letters in the email body are created based on the Task's setup 
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▪ Spreadsheets are created if a MyAssistant Spreadsheet Template is attached 

▪ Any reports from Sage menus are generated 

▪ Documents, spreadsheets and/or text files are created from any attached 

Crystal Reports 

 

Example: MyAssistant creates a separate email with a form letter for each Vendor, 

containing only their information. 

 

5. MyAssistant sends the emails 

Please note: A Task can only send emails if: 

▪ When run, the Task finds information in Sage that matches the criteria in its Condition 

▪ At least one recipient is specified in Task Setup 

▪ The Task is set up to run automatically on a schedule, or is manually triggered by 

selecting it and clicking "Run and Send" 

 

 

 

 



Copyright © 2023 Innovative Software Design 6 

 

How to Start Using MyAssistant 
Customers find early success with MyAssistant by starting with Prebuilt Tasks. Prebuilt Tasks 

are common things other companies have used MyAssistant to automate, and can be 

customized to meet each company's specific needs. This section steps through searching, 

activating and customizing prebuilt Tasks in order to review what can be sent. 

 

Determining What to Automate 

When thinking of ways to use Sage MyAssistant, start by building a list of things that you'd 

like to send yourself or others. 

To help, ask questions like: 

▪ What do I spend time tracking down / getting from others? 

▪ What information would I like sent to me without asking for it? 

▪ What reports/emails/etc. would I like automatically sent to someone?  

 

Next, review the “MyAssistant Prebuilt Task List” to find Tasks that you'd like to try out and 

see what you can receive. 

 

Setting up MyAssistant Tasks 

After determining what to automate with MyAssistant, the next step is to start setting up 

MyAssistant Tasks to perform the desired actions. Sage MyAssistant is installed with several 

hundred prebuilt Tasks that are ready to be used. As such, most Sage customers find success 

by starting with the following steps: 

1. Use Search: Quickly look through MyAssistant's 300+ prebuilt Tasks by clicking in 

the Search bar in the main MyAssistant window and typing a key word or phrase. This 

will filter the list of prebuilt Tasks to only those whose names include what was 

searched. 
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2. Select a Task to try out: Click a Task that sounds like it may provide the right 

information from the list under the search bar, then click the "Activate" button in the 

ribbon 

 

 

This will open the Task Setup window, starting in the "Condition" step. 

 

3. Review information that is found: Make sure the Task is looking up the desired 

information by clicking the "Preview" button in the "Condition" step. This will show all 

the information in Sage that meets the current criteria. 

 

Click "Next" in the bottom right to advance to the next step of Task Setup 
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4. (Optional) Choose a Sage data folder: If MyAssistant is set up to monitor multiple 

Sage data folders, choose at least one data folder that the Task will look up 

information for and send emails. Click "Next" when done to advance to the Schedule 

step of Task Setup 

 

Note: If MyAssistant is monitoring only one Sage data folder, this step will not appear. 

 

5. Skip the Schedule step: Accept the default setting of the Task only running "On 

demand" (i.e. it will only run when manually triggered) and click "Next" in the 

bottom-right. Schedules can be added to a Task later. 

 

6. Enter your email address: In the Email step, ensure you're the only recipient on the 

Task by clicking in and removing anything in the "To" line, then typing in your email 

address. Recipients can be changed on a Task at a later time. 

 

Click "Next" to advance to the last step of Task Setup. 

 

7. Accept the default Options: Leave all the settings alone on the last step of Task 

Setup (the "Options" step) and click "Finish" to close Task Setup 

 

8. Run the Task: After finishing Task Setup, send an email by clicking "Yes" when asked 

if the Task should be run and emails should be sent 

 

9. Identify any desired changes: Open and review the email received to determined 

what changes (if any) should be made to the MyAssistant Task 

 

10. Open the Task for edits: Reopen MyAssistant, select the Task from the list (Task 

name should now be bold and blue), and click the "Open" button in the ribbon in 

order to make changes to the Task. 

 

11. Change the email's content: Click "Email" on the left side of the window that opens 

to go back to the Email step. This step controls what recipients are sent, and is where 

to make changes like: 

▪ Adding or remove columns from the list sent in the body of the email 

▪ Turn the emailed list into an attached spreadsheet 

▪ Attach a report to the email 
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12. Save changes and re-send the email: After updating what the Task will send, click 

"OK" in the bottom-right of the window to save changes. Then, send a new email by 

selecting the Task and clicking "Run and Send": 

 

 

 

Send a List of Notifications Overview 
MyAssistant can send a list of items someone needs to look at (i.e. "Notifications"). Examples 

include Vendors with expiring insurance, Job costs posted to a closed Job, and missing 

Employee contact information.   

 

This outlines the steps to create a Task to send a list of Notifications (with links to more 

detailed steps): 

 

1. Create a new Task: Click the "New" button in the main MyAssistant window to create 

a new Task 

 

2. Pick what to send a list of: Choose to send a list in the "What to Send" step, then 

pick what you want to send a list of (for example: a list of Jobs) in the body of the 

email. Click here for a table that helps identify what record information is stored in 

based on where it's viewed or entered in Sage. 

 

3. Choose which items to send: Use a prebuilt or create a new Condition (for example: 

JC Jobs not billed in a specified number of days, AP Invoices not fully paid, PR 

Employees missing an email address, etc.) in the "What to Send" step to filter the list 

that's emailed to recipients. 

 

4. Set criteria of which items to send: Create or customize the Condition (for example: 

all open Jobs where the JTD Cost is greater than the Total Estimate) in the 

"Condition" step to ensure the MyAssistant is looking for only the items that should 

be in the list 

 

5. Schedule when the list is sent: Schedule how often the Task should automatically 

run and see if a list needs to be sent. 
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6. Create the list: Select the emailed list's columns by adding Sage fields to the table at 

the bottom of the "Email" step. 

 

7. Choose who to email: Specify the recipients that should be emailed when a list 

needs to be sent. An Email Directory can be used to send each recipient a list of only 

their items (for example: send each Project Manager only their Jobs).  

 

8. Finish setting up the Task: Confirm the last settings in the "Options" step and finish 

Task Setup  

 

 

Send a Spreadsheet Overview 
Information in Sage can be sent in a spreadsheet with MyAssistant. Examples include AR 

Aging Spreadsheets, Job Cost Breakdown spreadsheets, and AP cash flow spreadsheets. 

Spreadsheets can be added to MyAssistant Tasks using Spreadsheet Templates, which define 

the spreadsheet's content and layout. 

 

The following takes place when running a Task that sends a spreadsheet. 

1. The Task Condition criteria determines if a spreadsheet should be sent, and what 

information is in it. For example: 

a. Do any Vendors have missing or expired insurance? 

b. Are any Cost Codes over-budget ? 

c. Are there any AR Invoices that are past due? 

i. Click here for a table that helps identify what record information is stored 

in based on where it's viewed or entered in Sage. 

 

2. The Spreadsheet Template is used to create a spreadsheet that's attached to the email.  

a. If an Email Directory is specified in the Email Step of Task Setup, MyAssistant 

looks up an email address for each item found by the Condition, creates a 

separate email and filters the spreadsheet for each recipient. For example: An 

Email Directory can look up the Project Manager's email address on a Job that 

has over-budget Cost Codes. 

 

 

This outlines the steps to create a Task to send a Spreadsheet (with links to more detailed 

steps): 

 

1. Create a new Task: Click the "New" button in the main MyAssistant window to create 

a new Task 

 

2. Choose what to send a spreadsheet of: Choose to send a spreadsheet in the "What 

to Send" step, then pick what to send in the spreadsheet (for example: a spreadsheet 

of AP Invoices) attached to an email 
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3. Pick which items to send: Choose a prebuilt or create a new Condition (for example: 

AP Invoices not fully paid, JC Jobs not billed in a specified number of days, PR 

Employees missing an email address, etc.) in the "What to Send" step to filter the list 

that's used as part of creating the spreadsheet.  

 

4. Set criteria for which items to send: Create or customize the Condition (for 

example: AP Invoices not fully paid with an invoice date more than 30 days ago) in 

the "Condition" step to ensure MyAssistant is looking for the right information to 

include in the spreadsheet. 

 

5. Schedule when spreadsheets are sent: Schedule how often the Task should 

automatically run and see if a spreadsheet needs to be sent  

 

6. Create the spreadsheet: Choose what information is in the spreadsheet by selecting 

the Sage fields in the Notification Table in the "Email" Step, then create a spreadsheet 

template based on the table. 

  

7. Choose who to email: Specify the recipients that should be emailed when 

spreadsheets need to be sent. An Email Directory can be used to send each recipient 

a spreadsheet of only their items (for example: send each Project Manager only their 

Jobs).  

 

9. Finish setting up the Task: Confirm the last settings in the "Options" step and finish 

Task Setup 
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Send Reports & Documents Overview 
MyAssistant can automatically generate and send reports and documents; including filtering 

the content for each recipient. Examples include sending employees their pay stubs, 

customers their statements, and cost reports to project managers for their jobs. 

 

The following takes place when running a Task that sends reports or documents: 

1. The Task Condition determines if one or more reports / documents should be generated 

and sent based on its criteria. For example: 

a. Which employees were paid last week and need to receive a pay stub? 

b. Which vendors are out of compliance and need to receive a notice? 

i. Click here for a table that helps identify what record information is stored 

in based on where it's viewed or entered in Sage. 

 

2. When reports need to be sent to multiple people, the condition creates a mailing list (For 

example: A list of PR checks that were generated last week). This list is used along with an 

Email Directory to look up email addresses for each item (For example: Look up email 

addresses for each employee who received PR check). 

 

3. MyAssistant sorts the mailing list by email address and creates one email per recipient. 

 

4. Before each email is sent, attached reports are run and filtered for the recipient using 

report prompts. 

a. Report prompts filled in when running the report in Sage are used to filter the 

report content for each recipient. Settings in the Task Setup – Email step – Report 

Options window specify the information used to fill in each report prompt. For 

example: an “Employee” report prompt that filters the report to one person is 

filled in with the Employee ID from their PR Check record. 

 

5. Emails are sent when the attached report(s) are completed. 

 

Steps to Send the Same Report Content for all Recipients 

This outlines the steps to create a Task to send an attached report where everyone gets the 

same information (with links to more detailed steps): 

 

1. Create a new Task: Click the "New" button in the main MyAssistant window to create 

a new Task 

 

2. Choose to send a report: Choose to send "A report attached as a PDF" in the "What 

to Send" step 

 

3. Schedule when reports are sent: Specify whether the report(s) should be sent 

automatically on a Schedule in the "Schedule" step 

 

4. Pick which report(s) to send: Choose which report(s) should be emailed in the 

"Email" step and fill out any report prompts 
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5. Specify who to email: Specify the recipients that should be emailed the report(s) 

when the Task is ran 

 

6. Finish setting up the Task: Confirm the last settings in the "Options" step and finish 

Task Setup 

 

Steps to Send Each Person Only Their Information 

This outlines the steps to create a Task that sends each recipient reports & documents 

containing only their information: 

 

1. Confirm reports work and filter content properly: Test the report(s) or 

document(s) that will be sent with MyAssistant in Sage or Crystal Reports to make 

sure they run, and that the prompts will filter the content for each recipient (For 

example: testing a "Pay stub" Crystal Report to make sure it filters for the prompted 

Employee and Period End Date). 

 

2. Create a new Task: Click the "New" button in the main MyAssistant window to create 

a new Task 

 

3. Choose what to send: Select to send "Each person their reports or documents" in 

the "What to Send" step, then pick what Sage information to use to create a mailing 

list that determines who is and isn't sent an email (for example: using PR checks to 

find out which employees were paid last week and need to be emailed). 

 

4. Pick which mailing list to use: Choose a prebuilt or create a new Condition (for 

example: "PR checks (posted) that use Direct Deposit" to get a list of Employees paid 

in the last week) in the "What to Send" step to use as a mailing list. 

 

5. Define criteria for the mailing list: Create or customize the Condition (for example: 

PR Checks that aren't voided, have Direct Deposit amounts, are from the most recent 

pay period, and are for employees with an email address) to ensure MyAssistant 

creates an accurate mailing list based on the desired information.  

 

6. Schedule when reports are sent: Schedule how often the Task should automatically 

run and see if a reports or documents need to be sent  

 

7. Pick the report(s)/document(s) to send and personalize by recipient: Choose 

which report(s)/document(s) to send in the "Email" step; and fill out their prompts to 

filter the content for each recipient 

 

8. Add an Email Directory: Add an Email Directory that looks up an email address for 

each item on the mailing list; resulting in a separate email for each recipient (For 

example: Look up an email address for each employee who received a check to send 

them their pay statement).  
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9. Finish setting up the Task: Confirm the last settings in the Options step and finish 

Task Setup 

 

 

Task Setup 
MyAssistant monitors for specific situations based on your information in Sage and 

automatically informs someone using "Tasks". MyAssistant Tasks are the individual processes 

that do things like send each employee their pay stubs, notify Vendors when they have 

expiring insurance, email Customers their Service Management invoices, and more.  

 

Each MyAssistant Task has the following parts: 

 

Condition: What MyAssistant should monitor in Sage and the criteria that information 

should meet. Click here for a table that helps identify what record information is stored in 

based on where it's viewed or entered in Sage. 

Example: This Condition is looking for JC Cost Codes, and the criteria are: 

▪ Not a Group Cost Code 

▪ Not a closed Cost Code 

▪ Not on a Closed Job 

▪ The "Job-to-Date" Costs on a Cost Code are more than $500 over the "Total 

Estimate" 
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Sage Data Folders: If MyAssistant is monitoring multiple Sage data folders, you'll choose 

which data folders the Task will look through. 

 

 

Schedule: A schedule sets if and when a Task should automatically check Sage for 

information. 

 

Recipients/Email Directories: Specifies who should be emailed when the Task finds 

information that matches the criteria in the "Condition". Recipients can be specified by 

entering their email addresses on the Task, or MyAssistant can look up who to notify based 

on the information found.  

Email: Controls what the recipients are sent when the Condition's criteria are met. Emails 

can have attachments like: 

Attached Reports or Documents: Recipients can all be sent the same document 

with the same information, or each recipient can be sent only the information that 

pertains to them. For example: one Task can send all the manager the same cost 

report, while another Task can send each employee their weekly pay stub. 

Spreadsheet Template: Used to send an Excel spreadsheet attached to the email(s) 

sent by the Task. A spreadsheet template specifies what Sage information will be 

included in the spreadsheet and the spreadsheet's layout; regardless of how much 

information is found. 

 

Activating a Task 

To start using a prebuilt Task in MyAssistant, it must be activated. Activating a Task opens 

the Task Setup wizard, which steps through the preset settings on the Task so they can be 

customized. Specifying recipients and what each recipient receives is also part of activating a 

Task. 
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When a Task is activated, its font changes to bold and the color changes from black to blue. 

 

To activate a Task, select a Task displayed in black, non-bold font; and click "Activate" in the 

button bar: 

 

If this is the first time a Task is being activated, the Task Setup window will open. If not, a 

prompt will appear asking one of two things: 

▪ If MyAssistant is monitoring multiple Sage data folders, a prompt will appear to 

specify a Data Folder. After selecting a data folder, a prompt will appear to run the 

Task. 

▪ If MyAssistant is currently monitoring one Sage data folder, the prompt will ask if the 

Task should be run. 

Copy a Task 

Sometimes more than one Task that looks up the same information is needed; because each 

Task will send different emails to different recipients. For example: one Task may send each 

employee their pay statement every week, while a second Task sends a spreadsheet of all PR 

checks cut that week to someone in management. In this case, both Tasks need to look up 

PR Checks from the most recent pay period. 
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To save time in these situations, the first Task can be copied to create the second. A copied 

Task will initially have the same Condition, Schedule, recipients and email content as the first; 

which can all be changed without affecting the first Task. 

To copy a Task, select it in the main MyAssistant window and click "Copy" in the button bar. 

 

A window will open with a prompt to name the copied Task and choose if it should be 

activated. 

Deactivating a Task 

If a Task is no longer needed for any reason, it can be "deactivated"; or turned off. A 

deactivated Task cannot run or send emails, and will not appear in the "Activated Tasks" 

view.  

To deactivate a Task, select the Task displayed in bold, blue text in the main MyAssistant 

window and click "Deactivate" in the button bar 
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What to Send Step 
To help better understand the link between what is sent from a Task and how it's set up, 

creating a new MyAssistant Task starts with identifying what to send:  

 
This selection changes what is seen in MyAssistant to help educate how choices affect what's 

emailed. 

"What to Send" features the following options: 

List of Notifications: This option is for sending a list of information in the body of an email. 

 

Once this option has been selected, the next step will be to pick what the Task will send a list 

of in the body of the email. 
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Spreadsheet: Used to send an Excel spreadsheet attached to the email(s) sent by the Task.  

 

After selecting this option, the next step is to decide what should print on each line in the 

spreadsheet. 

 

Report attached as a PDF: This is used to send reports where every recipient gets the same 

information.  

 

Each person their report or documents: This option is used to send each recipient only 

their information. The next step after picking this option would be to identify what Sage 

information will be used to create a mailing list that will identify who needs to be emailed 

and who doesn't. 
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Send a List of Notifications 
To send a list of information in an email like the one pictured below, select "List of 

Notifications" in the "What would you like to send" dropdown. Next, click the dropdown 

next to "Send a list of" and pick what Sage information to send in a list. For example, to send 

a list of Jobs recently set up in Sage, select "JC Job" in the "Spreadsheet of" dropdown:  

 
 

Click here for a table that helps identify what record information is stored in based on where 

it's viewed or entered in Sage. 

Tip: Use the Search at the top and the "Frequently Used" group to quickly find what you want to send. 

 

Next, select a prebuilt Condition or choose to create a new one. The Condition determines 

which Sage records are sent to someone. The list of available Conditions is filtered to those 

that look at the same Sage record specified in the "Send a List of" (for example: Jobs, 

Vendors, etc.).  

 

Example: If you chose to send a list of "JC Jobs", the list will show only Conditions that also 

create a list of Jobs: 

 
Note: When activating a prebuilt Task or modifying a Task that has previously been 

activated, the "List of" record cannot be changed. 

 

Click Next to go to the Condition step to preview/customize the Condition. 
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Send a Spreadsheet 
To send a spreadsheet attached to an email like the one pictured below, select 

"Spreadsheet" in the "What would you like to send" dropdown. 

 

Next, click the dropdown next to "Spreadsheet of" and pick what Sage information you want 

listed in a spreadsheet. For example, to send a spreadsheet of Jobs recently set up in Sage, 

select "Jobs" from the "Spreadsheet of" dropdown:  

 

Click here for a table that helps identify what record information is stored in based on where 

it's viewed or entered in Sage. 

Tip: Use the Search at the top and the "Frequently Used" group to quickly find what you want to send. 

 

Next, select a prebuilt Condition or choose to create a new one. The Condition determines 

which Sage records are sent in a spreadsheet. The list of available Conditions is filtered to 

those that look at the same Sage record specified in the "Spreadsheet of" dropdown (for 

example: Jobs, Vendors, etc.).  
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Example: If "JC Jobs" is selected in the "Spreadsheet of" dropdown, the list will show only 

Conditions that also create a spreadsheet of Jobs: 

 
 

Note: When activating a prebuilt Task or modifying a Task that has previously been 

activated, the "Spreadsheet of" record cannot be changed. 

 

Click "Next" to go to the Condition step to preview/customize the Condition. 

 

 

Send a Report as a PDF 
Report attached as a PDF: This is used to send reports where the recipients are the same 

every time the Task is run, and every recipient gets the same information. If this option is 

selected, the Condition will be automatically selected and the next step will be scheduling 

the Task. 
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Each Person Their Report or Documents 
Each person their report or documents: This option is used to send each recipient only 

their information. After choosing to send "Each person their report or documents"; the next 

step is to identify what Sage information (i.e. record) will be used to create a mailing list. A 

mailing list identifies who needs to be emailed and who doesn't. 

 

Click the dropdown next to "Mailing list based on" and pick the Sage record to use. For 

example, to send each employee their pay statement, select "PR Check" to create a mailing 

list based on who was paid in the most recent pay period.   

 

 
 

Click here for a table that helps identify what record information is stored in based on where 

it's viewed or entered in Sage. 

 

Tip: Use the Search at the top and the "Frequently Used" group to quickly find what you want to send. 

 

Next, select a prebuilt Condition or choose to create a new one. The Condition determines 

which Sage records are used to create the mailing list. The Conditions list is filtered to those 

that look at the same Sage record specified in the "Mailing list based on" field. 

 

Example: If "PR Checks" selected in the "Mailing list based on dropdown", the list will show 

only Conditions that also create a mailing list based on PR Checks: 

 
 

Note: When activating a prebuilt Task or modifying a Task that has previously been 

activated, the "Mailing list based on" record cannot be changed. 

 

Select a prebuilt Condition or "NEW CONDITION", then click Next. You'll then customize and 

preview your criteria in the Condition step. 
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Condition Step 
MyAssistant Tasks monitor for specific situations using a Condition. Conditions are one or 

more logical statements that are true or false. For example: 

To See MyAssistant Condition 

Jobs that are over-budget 
JC Jobs with a Total Estimate greater than the Job-to-

date Costs 

Subcontracts that are not signed 
JC Commitments where the "Signed Received" box isn't 

checked and the Vendor's Type is "Subcontractor" 

AP Invoices Coded to a JC Cost 

Code without an Estimate 

AP Invoice Distributions where the associated JC Cost 

Code's "Total Estimate" is zero 

PR Employees paid this pay period PR Checks with a period end date in the last week and 

a Direct Deposit amount greater than zero 

 

When a Task runs, the Condition is applied to the Sage database and creates a list of Sage 

records. This list can be: 

▪ Included in the body of the email 

▪ Used to fill in a spreadsheet template, or 

▪ Used as a mailing list to send each recipient their reports or documents 

 

Click here for a table that helps identify what record information is stored in based on where 

it's viewed or entered in Sage. 

 

Condition Parts 

Each line of a Condition contains the following pieces: 

Sage field/MyAssistant Formula: The information from a Sage field or a MyAssistant 

Formula. Examples include: 

▪ Employee's Email Address  

▪ Invoice Date on an AR Invoice  

▪ Last time a Job was billed 

Operands: Used to compare the different values on a line. Examples include: 

▪ Equals   

▪ Is more than specified days ago  

▪ Is greater than  

▪ Contains  

▪ Is blank  

Related: All available operands 
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A specified value, Sage field or Formula: This is what's compared against the Sage field or 

MyAssistant Formula value in the line. This could be: 

▪ $4,000 

▪ 30 days 

▪ Accounting Date on an Invoice 

▪ Percent a category is over-budget 

 

When put together, Condition rows look like the following: 

 

 

Tip: When running a Task to send each person only their information, the Condition will also 

help determine who should be emailed and who shouldn't. Click here for more information. 
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Building a Condition 
 

The Condition on a Task is the criteria that filter the items you're looking for (for 

example: PR Checks, JC Jobs, AP Invoices, etc.) to only those you want. A detailed 

explanation of Conditions can be found here. 

This section outlines how to create or update the criteria of a Condition: 

Selecting the Sage Field / Formula  

Click the Sage field or formula on the left side of the row to show a list of the Sage 

information and formulas available to select. Expand the group that matches what you're 

looking for, then select the field to use in the row: 

 

Click here for a table that helps identify what record information is stored in based on where 

it's viewed or entered in Sage. 

 

Tip: Use the search bar at the top of the Sage field 

list to quickly find the Sage field to use in the row: 
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Select the Operand 

Click the "=", "begins with", or whatever symbol is between the Sage field or Formula and 

the space to put the value to check against. The list of available operands will change based 

on what kind of information is being looked up (i.e. text in a field, a number like a dollar 

amount, or a date) 

 

Related: All available operands 

 

Specify the field or Enter a Value 

Enter the value or select the Sage field or formula you want to compare against the first Sage 

field or formula selected. 

Click "Enter a value" to type in or select the value to check against the field: 
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To select a Sage field or formula: click the pencil icon, click the field & choose the correct 

Sage field or formula from the list: 

 

Add a row 

Adding rows to a Condition add additional criteria that the information in Sage has 

to meet to be included in the Task.  

To add a row to a Condition, click "Add Row" in the button bar at the top: 

 

Use the previous steps to modify the newly added row. 

 

Delete a row 

Remove a row from a Condition by hovering on the row, then clicking the "x" that 

appears to the right: 
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Add a group 

Add groups to combine or change optional and required criteria in a Condition by 

clicking "Add Group" in the ribbon. 

 

For more information on Groups, click here. 

 

Remove a group 

Remove a group from a Condition by hovering on the group heading, then clicking 

the "x" that appears to the right: 

 

For more information on Groups, click here. 
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Condition Groups 
Task Conditions contain one or more Groups that determine whether all or some of the 

criteria need to be met. There are two types of Groups: 

"AND" Groups: All criteria in the group must be met 

"OR" Groups: One of the criteria in the group must be met 

For Example: 

▪ Checking for current employees in multiple ways: An employee's Termination Date is 

blank, or their Termination Date is before the date entered in the Rehire Date field in 

PR Employee Setup 

▪ Checking for insurance information that was never entered, is expired, or is expiring 

soon: The General Liability "Ins Proof Req" checkbox in AP Vendor Setup is checked, 

and either the insurance expiration date is blank or the expiration date is in the next 

30 days or older 

Add or Change Groups 

Click "Add Group" at the top of the screen to add a group to the end of your Condition.  

 

 

In addition to the group, the first line under the group is automatically added. You can 

change this line using the options outlined in Building a Condition. 
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To change a group, click the "AND" or the "OR" above the lines of the Condition that you 

want to change, then select what you want to change it to: 

 

 

Tip: Add groups to the end of a Condition to help stay organized as to what criteria is falling 

under which group. It's technically possible (though not advised) to have criteria from an 

outer group under an inner group, but always putting groups at the end of your criteria 

ensures conditions are easy to read. 

 

Understanding Groups 

Criteria will always be indented under the group's heading, which most of the time will be an 

"AND" or an "OR" heading. 

 

"AND" group only 

If your condition only has several rows grouped under an "AND", the information being 

looked up in Sage must meet the criteria on every line in order to be included on an emails 

or attachments being sent by the Task: 
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What this means: This Condition is only looking for Jobs in Sage that meet all of its criteria: 

▪ The Job's Status field is "In progress", and 

▪ The Project Manager field on the Job is not blank, and 

▪ The Total Estimate on the Job is greater than or equal to $50,000 

 

If a Job did not meet all criteria, it would not be included in any emails or attachments sent 

by the Task. 

 

"OR" group only 

If your condition only has several rows grouped under an "OR", the information being looked 

up in Sage needs meet the criteria at least one of the lines in order to be included on an 

emails or attachments being sent by the Task: 

 

 
 

What this means: This Condition is looking for Employees missing address information in 

Payroll. In this case, the Condition wants to find any employees that meet one or more of the 

following criteria: 

▪ The "Address 1" field in Employee Setup is blank, or 

▪ The "City" field in Employee Setup is blank, or 

▪ The "State" field in Employee Setup is blank, or 

▪ The "Zip Code" field in Employee Setup is blank  

 

Only Employees that don't meet any of the criteria will be excluded from the emails or 

attachments sent by the Task. 

 

"AND" group with an "OR" group underneath 

Sometimes a condition will have several required criteria and some optional criteria, meaning 

you want to use both an "AND" and "OR" grouping. When you have an "OR" underneath an 

"AND" group, it means all the criteria outside the "OR" must be met, and at least one of the 

"OR" criteria: 
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What this means: This Condition is looking for specific Employees in Payroll. To be included 

in any emails or attachments sent by MyAssistant, an Employee must meet the first two 

criteria, and at least one of the criteria under the "OR":  

▪ An Employee is in the "Field" pay group, and 

▪ The "Email Address" field in Employee Setup is blank, and 

▪ Either 

▪ The "Termination Date" field in employee setup is blank, or 

▪ The "Termination Date" field is a date before the date in the "Rehire Date" 

field 

 

Employees who do not meet the first two lines of the criteria and at least one of the criteria 

under the "OR" will be excluded in any emails or attachments sent by the Task. 

 

 

Multiple "AND" and "OR" groups underneath one another 

As you get more comfortable with creating your own Conditions, you can have multiple 

groups underneath one another. When you have multiple groups, it's important to 

remember that all the criteria that are indented at the same level are what fall under that 

group: 

 

 
 

What this means: This Condition is looking for JC Jobs. To be included in any emails or 

attachments sent by MyAssistant, a Job must meet the first two criteria, and at least one of 

the criteria under the "OR". In this case, the second "OR" option actually has two criteria that 

both must be met: 

▪ The Job's status is "In progress", and 

▪ The Total Estimate on the Job is less than $125,000; and 

▪ Either 

▪ Option 1: The "Estimator" field on the Job is blank, or 

▪ Option 2: 

▪ The "Project Manager" field on the Job is blank, and 

▪ The "Project Manager Email" field on the Job is blank 
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Operands 
The list of available operands for a row in a Condition will change depending on the type of 

information being looked up. Operands are selected as part of building a Condition. 

 

Text Operands 

These operands are available when checking text entered in Sage. Common examples 

include AP Vendor ID, AR Customer Name, PR Employee Number, and JC Job Description. 

 

Operand Definition Example 

 

The text from the field or formula to the left of 

the operand matches the text entered or Sage 

field selected on the right 

To see all Subcontracts: 

 

 

The text from the field or formula to the left of 

the operand doesn't match the text on the 

right 

To see Jobs where the Project Manager isn't John Smith: 

 

 

The text to the right of the operand is 

somewhere in the text from the field on the 

left 

To see all Commitments where "wiring" is somewhere in the 

Commitment's Description: 

 

 
The text to the right of the operand is not 

anywhere in the text from the field on the left 

To see AR Customers where "University" is not in their name: 

 

 

The text from the field or formula on the left 

starts with the text entered or Sage field 

selected on the right 

To see all Jobs that begin with the "23": 

 

 

The text from the field or formula on the left 

ends with the text entered or Sage field 

selected on the right 

To see all Commitments on Jobs that end in "100": 

 

 

The text to the right of the operand is 

somewhere in the text from the field on the 

left 

To see all Employees that have "Admin" somewhere in their title: 

 

 
The text to the right of the operand is not 

anywhere in the text from the field on the left 

To see all Jobs where "NYC" is not in the description: 

 

 

The text from the field or formula to the left of 

the operand matches one of the options on 

the right 

To see Customers with an ID of "GA","OHSU", "TT" or "TC": 

 

 

The text from the field or formula to the left of 

the operand doesn't match any of the options 

on the right 

To see Employees that don't have an ID of 100, 101 or 103: 

 

 The field or formula specified is blank 
To see Employees with no Email Address in PR Employee Setup: 

 

 The text field is not blank 
To see Employees with Email Addresses in PR Employee Setup: 

 

 

The text from the field or formula to the left of 

the operand does not begin with the text 

entered or Sage field selected on the right 

To see Jobs with IDs that do not begin with "XX": 

 

 

The text from the field or formula to the left of 

the operand does not end with the text 

entered or Sage field selected on the right 

To see Cost Codes that do not end in "000": 
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Number Operands 

These operands are available when checking numbers entered in Sage. Common examples 

include the Total Estimate on a Job, the Net Pay amount on a PR Check, the number of Days 

Before Due entered in AR Customer Setup, and the number Payment Days in AP Vendor 

Setup. 

 

Operand Definition Example 

 

The number from the field or formula to the 

left of the operand equals the number 

entered or Sage field selected on the right 

To see AP Invoice Distributions with $0 paid: 

 

 

The number from the field or formula to the 

left of the operand doesn't equal the 

number entered or Sage field selected on 

the right 

To see Commitments where the amount invoiced isn't $0: 

 

 

The number from the field or formula to the 

left of the operand is greater than the 

number entered or Sage field selected on 

the right 

To see Cost Codes that are over-budget by more than five 

percent: 

 

 

The number from the field or formula to the 

left of the operand is greater than or equal 

to the number entered or Sage field 

selected on the right 

To see Commitments that are $500 or more: 

 

 

The number from the field or formula to the 

left of the operand is less than the number 

entered or Sage field selected on the right 

To see Cost Codes with revised Contract amounts less than 

$1,000: 

 

 

The number from the field or formula to the 

left of the operand is less than or equal to 

the number entered or Sage field selected 

on the right 

To see AP Invoices with $1,500 or less open on them: 

 

 

The number from the field or formula to the 

left of the operand is between the two 

numbers specified on the right 

To see Jobs with Total Estimates between $100,000 and 

$200,000: 

 

 
The number on the left is not between in the 

two numbers on the right 

To see Jobs with Revised Contracts not between $50,000 and 

$100,000: 

 

 

The number from the field or formula to the 

left of the operand is between the two 

numbers specified on the right 

To see Bank Accounts whose balances changed between 

$2,500 and $5,000 yesterday: 

 

 

The text from the field or formula to the left 

of the operand matches one of the numbers 

on the right 

To see AP checks numbered 100251, 100257, 100275 or 

100301: 

 

 

The text from the field or formula to the left 

of the operand doesn't match any of the 

numbers on the right 

To see Credit Card Payments with a Payment ID other than 

200150 or 200188: 
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Date Operands 

These operands are available when checking the value of a date field. Examples include the 

Period End Date on a PR Check, the Date Issued on a Lien Waiver, the Invoice Date on an SM 

Invoice, and the Accounting Date on a JC Transaction. 

 

Operand Definition Example 

 
The date from the field or formula to the left of the 

operand matches the day the Task is run 

To see AP Electronic Payments with a Payment Date 

matching the day the Task runs: 

 

 
The date from the field or formula to the left of the 

operand is before the day the Task is run 

 To see Subcontracts and Purchase Orders (i.e. 

Commitments) with a date prior to the day the Task 

runs: 

 

 
The date from the field or formula to the left of the 

operand is after the day the Task is run 

To see AP Invoices with a "Due Back Date" that is after 

the day the Task runs: 

 

 

The date from the field or formula to the left of the 

operand is between the day the Task runs and the 

number of days entered in the future 

To see AP invoices with a discount date in the 15 days 

after the date the Task is run: 

 

 

The date from the field or formula to the left of the 

operand is between the day the Task runs and the 

number of days entered in the past 

To see Transactions with a date in the 7 days prior to 

the date the Task ran: 

 

 

The date from the field or formula to the left of the 

operand is further in the future than the day the 

Task runs plus the number of days entered 

To see Jobs where the Estimated Completed Date is 

more than 90 days after the day the Task ran: 

 

 

The date from the field or formula to the left of the 

operand is further in the past than the day the 

Task runs minus the number of days entered 

To see AP Invoices dated more than 30 days before 

the date the Task ran: 

 

 

The date from the field or formula to the left of the 

operand is after the date the Task ran minus the 

number of days entered or in the future 

To see PR Checks with Period End Dates in the 6 days 

before the Task ran, the same day the Task runs, or in 

the future: 

 

 

The date from the field or formula to the left of the 

operand is after the date the Task ran minus the 

number of days entered or in the past 

To see Vendors with Worker's Comp Insurance 

expiring in the 30 days after the Task runs, the same 

day the Task runs, or in the past: 

 

 

The date from the field or formula to the left of the 

operand is between the two dates entered or Sage 

fields selected on the right 

To see Jobs with Estimated Completion Dates between 

6/30/2022 and 12/31/2022: 

 

 

The date from the field or formula to the left of the 

operand is sometime in the calendar year after the 

date when the Task is run 

To see PR Checks dated for the calendar year after the 

day the Task runs: 

 

 

The date from the field or formula to the left of the 

operand matches the date entered or Sage field 

selected on the right 

To see Vendors whose General Liability Insurance will 

expire on 12/31/2022: 

 

 

The date from the field or formula to the left of the 

operand doesn't match the date entered or Sage 

field selected on the right 

To see AP Invoices where the Invoice Date doesn't 

match the Accounting Date: 

 

 

The date from the field or formula to the left of the 

operand is after the date entered or Sage field 

selected on the right 

To see Jobs where the Last Cost Update was after the 

last time the Job was billed: 

 

 

The date from the field or formula to the left of the 

operand is the same day as or later than the date 

entered or field selected on the right 

To see PR Checks with a Period End Date the same day 

or after the Check Date: 
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The date from the field or formula to the left of the 

operand is before the date entered or field 

selected on the right 

To see Subcontracts and Purchase Orders (i.e. 

Commitments) with dates prior to the date when a 

signed contract was received: 

 

 

The date from the field or formula to the left of the 

operand is the same day as or before the date 

entered or field selected on the right 

To see Jobs where the Actual Completion Date is the 

same day or prior to its Last Cost Update: 

 

 
The date from the field or formula to the left of the 

operand is blank 

To see AP Vendors where the Expiration Date for their 

Worker's Comp insurance has not been entered in 

Sage: 

 

 
The date from the field or formula to the left of the 

operand is not blank 

To see Jobs that have had overtime and when they 

had it: 

 

 

The date from the field or formula to the left of the 

operand is between the two dates entered or Sage 

fields selected on the right 

To see Credit Card payments dated between 

12/1/2022 and 12/31/2022: 

 

 

The date from the field or formula to the left of the 

operand is not between the two dates entered or 

Sage fields selected on the right 

To see Vendors whose most recent invoices were not 

between 1/1/2022 and 12/31/2022: 

 

 

The date from the field or formula to the left of the 

operand is after the day the Task runs but still in 

the same year 

To see Cost Codes with Estimated Completion Dates 

later in the same year the Task was run: 

 

 

The date from the field or formula to the left of the 

operand is between the day the Task runs and 30 

days in the future 

To see Employees who have an employment 

anniversary in the next 30 days: 

 

 

The date from the field or formula to the left of the 

operand is between the day the Task runs and 7 

days in the future 

To see Subcontracts and Purchase Orders (i.e. 

Commitments) with a Delivery Date in the next 7 days 

after the Task is run: 

 

 
The date from the field or formula to the left of the 

operand is in the year the Task runs 

To see Vendors who have been cut a check in the year 

the Task is run: 

 

 
The date from the field or formula to the left of the 

operand is in the month the Task runs 

To see Jobs that last had a billing in the month the 

Task is run: 

 

 

The date from the field or formula to the left of the 

operand is between the day the Task runs and 7 

days prior 

To see PR Checks with a Check Date in the last 7 days: 

 

 

The date from the field or formula to the left of the 

operand is between the day the Task runs and 30 

days prior 

To see AP Invoices with an Accounting Date in the last 

30 days: 

 

 

The date from the field or formula to the left of the 

operand is before the day the Task runs but still in 

the same year 

To Employees who were hired earlier in the year the 

Task runs: 

 

 

The date from the field or formula to the left of the 

operand is from before the calendar year when the 

Task was run 

To see Subcontracts and Purchase Orders (i.e. 

Commitments) with a Last Check Date from a year 

before to the year the Task is run:  

 

 

The date from the field or formula to the left of the 

operand matches the date entered or Sage field 

selected on the right 

To see AP Invoices where the Invoice Date is the same 

day as the Payment Date: 

 

 
The date from the field or formula to the left of the 

operand is any day in the month the Task was run 

To see AP Electronic Payments made in the same 

month the Task is run: 
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The date from the field or formula to the left of the 

operand is any day in the week the Task is run 

To see Jobs with an Actual Start Date in the same 

week the Task is run: 

 

 

The date from the field or formula to the left of the 

operand is any day in the calendar year the Task is 

run 

To see PM Leases with an Actual End Date in the same 

year the Task is run: 

 

 

The date from the field or formula to the left of the 

operand is in the month after the month the Task 

is run 

To see Vendors with Auto Insurance expiring in the 

month after the month the Task is run: 

 

 
The date from the field or formula to the left of the 

operand is in the year after the year the Task is run 

To see Subcontracts and Purchase Orders (i.e. 

Commitments) scheduled to start in the year after 

when the Task is run: 

 

 

The date from the field or formula to the left of the 

operand is in the month before the month the 

Task is run 

To see AP Checks cut in the month before when the 

Task is run: 

 

 

The date from the field or formula to the left of the 

operand is in the year before the year the Task is 

run 

To see Employees terminated in the year before when 

the Task is run: 

 

 

The date from the field or formula to the left of the 

operand is between the day the Task runs and the 

beginning of the year 

To see AP Invoices entered from the beginning of the 

year up to when the Task is run: 

 

 
The date from the field or formula to the left of the 

operand is in the month of January in any year 

To see Employees with a birthday in January: 

 

 
The date from the field or formula to the left of the 

operand is in the month of February in any year 

To see Employees that were hired in the month of 

February: 

 

 
The date from the field or formula to the left of the 

operand is in the month of March in any year 

To see Employees with a birthday in March: 

 

 
The date from the field or formula to the left of the 

operand is in the month of April in any year 

To see Employees that were rehired in the month of 

April: 

 

 
The date from the field or formula to the left of the 

operand is in the month of May in any year 

To see Employees with a birthday in May: 

 

 
The date from the field or formula to the left of the 

operand is in the month of June in any year 

To see Employees with a birthday in June: 

 

 
The date from the field or formula to the left of the 

operand is in the month of July in any year 

To see Employees that were hired in the month of July: 

 

 
The date from the field or formula to the left of the 

operand is in the month of August in any year 

To see Employees with a birthday in August: 

 

 
The date from the field or formula to the left of the 

operand is in the month of September in any year 

To see Jobs completed in the month of September: 

 

 
The date from the field or formula to the left of the 

operand is in the month of October in any year 

To see Employees terminated in the month of in 

October: 

 

 
The date from the field or formula to the left of the 

operand is in the month of November in any year 

To see Employees with a birthday in November: 

 

 
The date from the field or formula to the left of the 

operand is in the month of December in any year 

To see Employees with a birthday in December: 
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Advanced Conditions 
IMPORTANT  

This section is about "Advanced Conditions" in MyAssistant; created by clicking "Convert to 

Advanced" in the Condition Step of Task Setup. For information on standard Conditions, 

click here. 

 

Advanced Conditions define what a Task is looking for in two parts: the Check All record and 

the Condition Expression. 

 

The Check All record is what you want a list of; i.e. vendors, jobs, invoices, etc. 

 

The Condition Expression is what you are looking for in that list. For example: Vendors with 

expiring insurance, Jobs that haven’t been billed in 40 days, or Customers with a balance 

over a certain dollar amount. 

 

MyAssistant comes with numerous Conditions that are predefined and ready to use in Tasks. 

To access these Conditions go to File > Define Conditions. From the Define Condition 

dialog you can open the predefined Conditions and make copies so that you can make 

changes, or you can write your own conditions. There are also examples that show how to 

use various functions.  

 

 

Understanding Advanced Conditions 
IMPORTANT  

This section is about "Advanced Conditions" in MyAssistant; created by clicking "Convert to 

Advanced" in the Condition Step of Task Setup. For information on standard Conditions, 

click here. 

 

MyAssistant Conditions define the situations you like monitored. The MyAssistant software 

comes with many prebuilt Conditions that can be used as-is or copied and modified. The 

following outlines how to read or interpret a condition to determine if it will meet your 

needs. 

A condition has two parts: 

• Which Sage 300 CRE database records will be checked (Check All) 

• What is checked for each record (Condition Expression) 
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Check All 

The first step in determining if a condition will meet your needs is to check the Sage 300 CRE 

record specified in the Check All field. 

When a condition is run, MyAssistant performs the test specified in the Condition Expression 

for each occurrence of the Sage 300 CRE database record specified in the Check All field. A 

notification is created when the test is true. For example, if JC Job is select in the Check All 

field, MyAssistant will execute the test specified in the Condition Expression and create one 

notification for each job that meets the condition. 

 

Condition Expression 

The Condition Expression defines what is tested when the condition runs. The Condition 

Expression can be one or more logic statements that result in true or false. A logic statement 

can contain Sage 300 CRE database fields, specified values, functions and mathematical 

operands. Each logic statement is separated with an AND or OR operand and can be 

grouped together with parenthesis. The Condition Expression is reviewed by stepping 

through each logic statement. 

 

The following may be included in the Condition Expression: 

• Sage 300 CRE database fields – Sage 300 CRE database record / field names are 

surrounded with double quotes. They appear as "Record"."Field"; for example: 

"APM_MASTER__INVOICE"."Invoice_Date". 

• Specified Values – Specified values are formatted based the type of data. Text 

values are specified with single quotes, dates are specified with single quotes in the 

format 'YYYY-MM-DD', and numbers do not use any quotes or other symbols. 

• Functions – Functions include things such as CURDATE() to specify today's date 

and IS NULL as test for a blank date. See the Function list for a definition of each 

available function. 

 

The following are a few sample logic statements that use Sage 300 CRE fields, functions, 

mathematical operators and specified values: 

 

This tests for the type being equal to Subcontractor. Use single quotes to specify the value of 

a text field: 

"APM_MASTER__VENDOR"."Type" = 'Subcontractor' 

 

This tests for the Vendor's Outstanding Amount being greater than 10000. Do not use 

quotes to specify a number: 

"APM_MASTER__VENDOR"."Outstndg_Amount" > 10000 
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This tests whether a date field is blank: 

"APM_MASTER__INVOICE"."Invoice_Date" IS NULL 

 

This tests whether the discount date is within seven days of today: 

"APM_MASTER__INVOICE"."Discount_Date" <= CURDATE()+7 

 

This tests whether JTD Cost minus the Total Estimate is greater than or equal to 500. 

(Although 500 is a dollar amount, the dollar symbol ($) is not used): 

"JCM_MASTER__JOB"."JTD_Cost" - "JCM_MASTER__JOB"."Total_Estimate" >= 500 

 

This tests for any accounts where the first two characters on the left are 10. Since this is an 

alpha field, quotes are used around the specified value. Use the Browse Data feature to 

determine the field type: 

LEFT("GLM_MASTER__ACCOUNT"."Account", 2) = '10' 

 

This tests for an invoice date that is greater than or equal to January 15, 2005. Use single 

quotes to specify the value of a date field: 

"APM_MASTER__INVOICE"."Invoice_Date" >= '2005-01-15' 

 

Creating New Advanced Conditions 

IMPORTANT  

This section is about "Advanced Conditions" in MyAssistant; created by clicking "Convert to 

Advanced" in the Condition Step of Task Setup. For information on standard Conditions, 

click here. 

 

Conditions can be created while you are creating a new Task. 

To create a Condition: 

1. Select File > Define Conditions. 

2. In the Condition Name field, enter the new Condition name. Each Condition must 

have a unique name. 

3. From the Application dropdown list, select the application that contains the data 

record that MyAssistant should look through when applying this condition. Your 

selection here determines what "Check All" options are available. 

4. From the Check All dropdown list, select the record that MyAssistant should look 

through when running the condition. For example, if you would like to check each 

vendor for a specific situation, select AP Vendor. 

5. From the Category dropdown list, select the Category to which you want this 

condition added. If you wish to create a new Category, click Add. Conditions that are 
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not assigned a Category are listed in a group titled Uncategorized Conditions. 

6. In the Description field, enter a description of the Condition. This description is 

displayed when you select a Condition while setting up a task. 

7. Enter your Condition statement(s) in the Condition Expression area. 

 

A Condition is a test that results in a true or false statement. A Condition can contain one or 

more expressions, connected with "AND"s and "OR"s. You can use the tree on the left to 

select database fields from the Check All record or associated records. Once a field is added 

to the Condition Expression, it will appear in a "TABLE NAME"."Field Name" format. Both the 

table name and field name are surrounded by quotes and are case sensitive. For example, 

the Accounts Payable vendor name would appear as: 

"APM_MASTER__VENDOR"."Vendor_Name" 

Often conditions check to see if something is zero or blank. Specifying that something is 

blank varies by data type:  

• Number: Enter the number zero. 

• Text: Enter two single quotes: ''. 

• Date: Use the IS NULL function. 

 

You can also enter a mathematical expression such as adding two fields together. For 

example, the following would subtract the AP tax amount from the invoice amount: 

"APM_MASTER__INVOICE"."Amount" - "APM_MASTER__INVOICE"."Tax" 

 

Testing Advanced Conditions 
IMPORTANT  

This section is about "Advanced Conditions" in MyAssistant; created by clicking "Convert to 

Advanced" in the Condition Step of Task Setup. For information on standard Conditions, 

click here. 

 

You can use the Test button in the Define Condition dialog to make sure you are returning 

the data that you expect. Once the test has run, the results will be displayed in a new 

window. You can change the view of the results by adding data columns or sorting the 

results by a different column. 

To add Columns to the results table: 

Expand a data table in the Available Columns list 

Select the Sage 300 CRE data field that you wish to view in the test 

Click on the right arrow to add the field to the list of Columns in the results. 

Click Update Result 
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To Sort the Results by a given column, click the column header in the results pane at the 

bottom. The results will be sorted in ascending order. Click the column header again to sort 

by that column in descending order. 

If the results that you receive in the Test Condition dialog are not what you expect, verify 

that the Condition Expression is written properly. For more information, please refer to 

Understanding Conditions. 

Please note: The changes made in the test window are not applied to any task. The columns 

selected in the Test Condition dialog are used solely for that test. 

 

Selecting Advanced Conditions 
IMPORTANT  

This section is about "Advanced Conditions" in MyAssistant; created by clicking "Convert to 

Advanced" in the Condition Step of Task Setup. For information on standard Conditions, 

click here. 

 

When you click Open in the Define Condition dialog, you have a choice between User 

Conditions and Built-In Conditions. Once you have selected the condition you wish to work 

with, click OK to view the condition in its entirety. 

User Conditions 

Any conditions that you create will be saved on the User Condition tab. You will also notice 

that there are several example conditions on the User Condition tab. These examples show 

how to use various functions in the Condition Expression. 

Built-In Conditions 

MyAssistant comes with 340 prebuilt conditions. They are designed to be used right out of 

the box and can be customized during Task setup. If the prebuilt condition is close to what 

you need, but you wish to modify it slightly, this can be done by opening the condition, then 

copying it so that you can make changes. The copied condition will be saved on the User 

Conditions tab. 
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Copying Advanced Conditions 
IMPORTANT  

This section is about "Advanced Conditions" in MyAssistant; created by clicking "Convert to 

Advanced" in the Condition Step of Task Setup. For information on standard Conditions, 

click here. 

 

MyAssistant comes with various prebuilt Conditions. Some of these will fit your needs right 

out of the box; others will need to be modified. Prebuilt Conditions do not allow you to 

make changes, instead they must be copied, and then the copy may be modified. This way 

the original Condition is always available to reference or use. In addition, you can copy the 

conditions that you write. 

 

To copy a Condition: 

Click File > Define Conditions 

Click Open 

Select the Condition you would like to edit, then click OK 

Click Copy in the toolbar 

Enter a unique name for the Condition, the click OK 

Modify the Condition 

Click Save 

 

Editing Advanced Conditions 
IMPORTANT  

This section is about "Advanced Conditions" in MyAssistant; created by clicking "Convert to 

Advanced" in the Condition Step of Task Setup. For information on standard Conditions, 

click here. 

 

You may edit any custom Condition. In addition, you may copy a prebuilt Condition and 

make changes to the copy. 

To edit a Condition: 

1. Click File > Define Conditions 

2. Click Open 

3. Select the Condition you would like to edit, then click OK 

 

Please note: Editing a Condition will change the Condition for all Tasks that use that 

Condition. If you don’t want all the Tasks using that Condition to be affected, copy the 

Condition and use the copy to make the changes. 
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Deleting Conditions 

IMPORTANT  

This section is about "Advanced Conditions" in MyAssistant; created by clicking "Convert to 

Advanced" in the Condition Step of Task Setup. For information on standard Conditions, 

click here. 

 

To Delete a Condition: 

Make sure no Tasks are using the Condition you would like to delete 

Click File > Define Conditions 

Click Open 

Select the Condition you would like to delete, then click OK 

Click Delete in the toolbar. A confirmation message will be displayed. 

Please note: Prebuilt Conditions may not be deleted. 

 

Functions 
IMPORTANT  

This section is about "Advanced Conditions" in MyAssistant; created by clicking "Convert to 

Advanced" in the Condition Step of Task Setup. For information on standard Conditions, 

click here. 

 

Functions are built-in procedures or subroutines used to evaluate, make calculations on, or 

transform data. You can use one or more functions when you define a condition. 

 

IN - Test a field for multiple values 

CURDATE() - Current Date 

DAYOFMONTH() - Day of the month 

DAYOFWEEK() - Day of the week 

MONTH() - Month of the year 

YEAR() - Year 

LENGTH() - Length of text 

CONCAT() - Concatenate 

LTRIM() - Remove space characters from the left side of a text field 
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RTRIM() - Remove space characters from the right side of a text field 

SUBSTRING() - Return a portion of a text field 

LOCATE() - Find a substring in a text field 

LEFT() - Display a given number of characters from the left of a text field 

RIGHT() - Display a given number of characters from the right of a text field 

CONVERT() - Convert a given field to another data type 

IS NULL/IS NOT NULL - Determine if a field is (or is not) blank 

NOT() - Switch boolean value of a field 

UCASE() - Convert text to UPPER CASE 

LCASE() - Convert text to lower case 

IN - Test a field for multiple values 

The IN operator tests a given field against a list of values, and returns true if the field 

matches an item in the list. You can wrap an expression in the NOT() function to determine if 

a field is not one of the set of values. 

 

 Syntax: IN (comma separated list) 

 

 Examples: 

To show all GL Accounts of type Current assets and Noncurrent assets: 

"GLM_MASTER__ACCOUNT"."Account_Type" IN ('Current assets','Noncurrent assets') 

To show all GL Accounts that are not Suspense or Units accounts: 

NOT("GLM_MASTER__ACCOUNT"."Account_Type" IN ('Suspense','Units')) 
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CURDATE() - Current Date 

The CURDATE() function returns the current system date. This value can then be compared to 

other database date fields or can be part of an expression. Adding or subtracting a number 

from CURDATE() changes the result by the specified number of days. 

 

 Syntax: CURDATE() 

 The function is used with no parameters. 

 

 Examples: 

To show all posted GL transactions for today: 

"GLT_CURRENT__TRANSACTION"."Accounting_Date" = CURDATE() 

To show all JC Jobs that started in the last 7 days: 

"JCM_MASTER__JOB"."Actual_Start_Date" >= CURDATE() – 7 

DAYOFMONTH() - Day of the month 

The DAYOFMONTH() function returns the day of the month (1 through 31) from the given 

date parameter. 

 

 Syntax: DAYOFMONTH(<date>) 

 The function takes one parameter, a date field. This can be a database field or the 

CURDATE() function. 

 

 Examples: 

To show posted JC transactions that occurred on the first day of any month: 

DAYOFMONTH("JCT_CURRENT__TRANSACTION"."Accounting_Date") = 1 

This function could be combined with the MONTH() function to see if today is an employee’s 

employment anniversary date: 

MONTH("PRM_MASTER__EMPLOYEE"."Hire_Date") = MONTH(CURDATE()) AND 

DAYOFMONTH("PRM_MASTER__EMPLOYEE"."Hire_Date") = DAYOFMONTH(CURDATE()) 
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DAYOFWEEK() - Day of the week 

The DAYOFWEEK() function returns the day of the week (1 through 7, Sunday is the first day 

of the week) from the given date parameter. 

 

 Syntax: DAYOFWEEK(<date>) 

 The function takes one parameter, a date field. This can be a database field or the 

CURDATE() function. 

 

  Example: 

To show AP Invoices that have an Invoice date that falls on a Monday: 

DAYOFWEEK("APM_MASTER__INVOICE"."Invoice_Date") = 2 

 

MONTH() - Month of the year 

The Month() function returns the month of the year (1 through 12) from the given date 

parameter. 

 

 Syntax: MONTH(<date>) 

 The function takes one parameter, a date field. This can be a database field or the 

CURDATE() function. 

 

 Examples: 

To show any AP checks that were written in the month of June: 

Month("APM_MASTER__CHECK"."Check_Date") = 6 

This function could be combined with the DAYOFMONTH() function to see if today is an 

employee’s employment anniversary date: 

MONTH("PRM_MASTER__EMPLOYEE"."Hire_Date") = MONTH(CURDATE()) AND 

DAYOFMONTH("PRM_MASTER__EMPLOYEE"."Hire_Date") = DAYOFMONTH(CURDATE()) 
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YEAR() - Year 

The YEAR() function returns the year from the given date parameter. 

 

 Syntax: YEAR(<date>) 

 The function takes one parameter, a date field. This can be a database field or the 

CURDATE() function. 

 

 Examples: 

To find CM Transactions entered in the current year: 

YEAR("CMT_REGISTER__TRANSACTION"."Accounting_Date") = YEAR(CURDATE()) 

To find CM Transactions from last year that should be moved to the history file: 

YEAR("CMT_REGISTER__TRANSACTION"."Accounting_Date") = YEAR(CURDATE()) – 1 

 

LENGTH() - Length of text 

The LENGTH() function returns the number of characters in a string of text. 

 

 Syntax: LENGTH(<text>) 

 The function takes one parameter, a text field, and returns the number of characters in it 

(including spaces). 

 

 Example: 

To show any JC Jobs with a description longer than 20 characters (which may not appear well 

on some reports): 

LENGTH("JCM_MASTER__JOB"."Description") > 20 

 

CONCAT() - Concatenate 

The CONCAT() function puts two text fields together. 

 

 Syntax: CONCAT(<text1>,<text2>) 

 The function takes two parameters, both are text fields, and returns them joined together. 

 

 Example: 

For a JC Job record where Job='03-001' and Description='NW Food Warehouse', then using 

the function like this: 
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CONCAT("JCM_MASTER__JOB"."Job", "JCM_MASTER__JOB"."Description") 

would return the value: 03-001NW Food Warehouse. 

 

LTRIM() - Trim space characters from the left side of a text field 

The LTRIM() function removes preceding spaces from the beginning of a text field. 

 

 Syntax: LTRIM(<text>) 

 The function takes one parameter, a text field, and returns the text field with spaces at the 

beginning removed. 

 

 Example: 

This formula could be used to return records where a name was accidentally entered with a 

space in front of it (which would prevent that field from sorting correctly): 

LTRIM("APM_MASTER__VENDOR"."Name") <> "APM_MASTER__VENDOR"."Name" 

 

RTRIM() - Trim space characters from the right side of a text field 

The RTRIM() function removes succeeding spaces from the end of a text field. 

 

 Syntax: RTRIM(<text>) 

 The function takes one parameter, a text field, and returns the text field with spaces at the 

end removed. 

 

 Example: 

This formula could be used to return records where a name was accidentally entered with a 

space at the end of it: 

RTRIM("APM_MASTER__VENDOR"."Name") <> "APM_MASTER__VENDOR"."Name" 
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SUBSTRING() - Return a portion of a text field 

The SUBSTRING() function returns a specified amount of text from a specified position of the 

given text field. 

 

 Syntax: SUBSTRING(<text>, starting position [, length]) 

 The function can take 2 or 3 parameters. 

The first parameter is the text field to be searched 

The second parameter is the starting position of the substring (The first character of the text 

field is position 1) 

The third parameter is optional. It is the number of characters to get from the starting 

position. If this parameter is left out, the function will return text starting from the starting 

position all the way to the end of the text field.  

Examples: 

If you know the prefix length of an account in GL is 9 characters (including dashes), and there 

was no suffix, you can use this function to get just the base account. If you wanted to show 

all posted transactions to base account 5120 (and the account format was xxx- xxxx-xxxx): 

SUBSTRING("GLT_CURRENT__TRANSACTION"."Account",10) = '5120' 

In the same situation as above, but the account format contained a suffix that you wanted to 

ignore (xxx-xxxx-xxxx.xx): 

SUBSTRING("GLT_CURRENT__TRANSACTION"."Account",10,4) = '5120' 

 

LOCATE() - Find a substring in a text field 

The LOCATE() function performs a case-sensitive search of a text field for a given string of 

text, and returns the position of the text being searched. If the text you are looking for is not 

found, then this function returns 0. 

 

 Syntax: LOCATE(<text to find>, <field to search> [, starting position]) 

 The function can take 2 or 3 parameters. 

The first parameter is the text you want to find. 

The second parameter is the text field you want to search. 

The third parameter is optional. It is the position where you want to start looking (the first 

character is at position 1). If this field is left out, then it will start looking at the beginning of 

the text field. 

 Examples: 
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If you want to show all AP Vendors that have "LLC" anywhere in their name: 

LOCATE('LLC', "APM_MASTER__VENDOR"."Name") 

If you want to show all PM Properties that have the word "Garage" anywhere in the property 

name, except for properties that begin with the word "Garage": 

LOCATE('Garage', "PMP_PROPERTY__PROPERTY"."Name", 2) 

 

LEFT() - Display a given number of characters from the left of a text field 

The LEFT() function returns a specified number of characters from the left side of a text field. 

 

 Syntax: LEFT(<text>, length) 

 The function takes 2 parameters. The first parameter is the text field to use. The second 

parameter is the number of characters to return from the left side of the string. 

 

 Example: 

If the JC Cost Code field is formatted xxx- xxxx, where the first 4 characters are the Group 

Cost Code, and you wanted to use that to show all cost codes in the 400 group: 

LEFT("JCM_MASTER__COST_CODE"."Cost_Code",3) = '400' 

 

RIGHT() - Display a given number of characters from the right of a text field 

The RIGHT() function returns a specified number of characters from the left side of a text 

field. 

 

 Syntax: RIGHT(<text>, length) 

 The function takes 2 parameters. The first parameter is the text field to use. The second 

parameter is the number of characters to return from the RIGHT side of the string. 

 

 Example: 

If the JC Job field is formatted xxxx-xxxx, where the last 4 characters represent the year the 

job started, and you wanted to use that to show all jobs that started in 2005: 

RIGHT("JCM_MASTER__JOB"."Job", 4) = '2005' 

 

CONVERT() - Convert a given field to another data type 
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The CONVERT() function changes the type of a field to a specified type. 

 

 Syntax: CONVERT(<field>, <type>) 

 The function takes two parameters. The first parameter is the field to be converted. The 

second parameter is the data type to convert to. The following is a list of those types: 

SQL_BIT (1 = TRUE, 0 = FALSE) 

SQL_DATE (year, month, day) 

SQL_DECIMAL 

SQL_DOUBLE 

SQL_REAL 

SQL_INTEGER (use this if you want to drop the decimal part of a number, not to round). 

SQL_VARCHAR (use this to convert to text) 

Examples: 

If the JC Job field was formatted as xx-xxxx, where the last four characters represented the 

year in which the job started, using the RIGHT() function to get the year would return the 

year as text. If you wanted to compare that value to the current year using YEAR(CURDATE()), 

the year would be returned as an integer. You can convert the number to text and then 

compare: 

RIGHT("JCM_MASTER__JOB"."Job", 4) = CONVERT(YEAR(CURDATE()),SQL_VARCHAR) 

To create a date from text: 

CONVERT('2006-01-31', SQL_DATE) 

 

IS NULL/IS NOT NULL - Determine if a field is (or is not) blank 

These expressions are used to determine if a field is or is not null (empty). Dates can be 

empty, as can many text or numeric fields before they are given a value. A field is Null is 

different from it containing a 0 or blank. 

 

 Syntax: <field> IS NULL –or– <field> IS NOT NULL 

 Use this expression to determine if the field is empty. 

 

 Examples: 
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To show all PR Employees who have not been terminated: 

"PRM_MASTER__EMPLOYEE"."Terminate_Date" IS NULL 

To show all AP Invoices that have a Discount Date entered: 

"APM_MASTER__INVOICE"."Discount_Date" IS NOT NULL 

To see CM Transactions where the payee field is blank: 

"CMT_REGISTER__TRANSACTION"." Payee" IS NULL OR 

"CMT_REGISTER__TRANSACTION"."Payee" = '' 

 

NOT() - Switch boolean value of a field 

The NOT() function will reverse the value of the expression within the parentheses. If the 

expression results to TRUE, then the resulting value after the NOT operation will be FALSE. If 

the expression results to FALSE, then the resulting value after the NOT operation will be 

TRUE. 

 

 Syntax: NOT(<logical expression>) 

 Reverses the value of the expression. 

 

 Examples: 

To show all AP vendors who are not 1099 recipients: 

NOT("APM_MASTER__VENDOR"."Receives_Form_1099" = 1) 

To show all GL Accounts that are not Suspense or Units accounts: 

NOT("GLM_MASTER__ACCOUNT"."Account_Type" IN ('Suspense','Units')) 

 

UCASE() - Convert text to UPPER CASE 

The UCASE() function makes the specified text field all upper case. 

 

 Syntax: UCASE(<text field>) 

 Converts the specified text field to upper case. 
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 Examples: 

To show all AP Vendor IDs that are not in all upper case letters: 

UCASE("APM_MASTER__VENDOR"." Vendor") <> " APM_MASTER__VENDOR"."Vendor" 

 

LCASE() - Convert text to lower case 

The LCASE() function makes the specified text field all lower case. 

 

 Syntax: LCASE(<text field>) 

 Converts the specified text field to lower case. 

 

 Examples: 

To show all Invoices with the word "window" in the description: 

LOCATE('window', LCASE("APM_MASTER__INVOICE"."Description") 
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Data Folders 
When configuring the MyAssistant Server, you can choose to have MyAssistant monitor and 

report on multiple Sage data folders. If MyAssistant is set up this way, you'll choose in Task 

Setup which data folder(s) you want to run a Task for. to choose which data folders it will run 

for. 

 

Tasks can be run on more than one data folder, and you can change which data folder(s) a 

Task runs on after it has been initially set up. 

 

If MyAssistant is only monitoring one Sage data folder, this step will be skipped in Task 

Setup. 

 

Tip: Use the preview in the Condition step to confirm that each Sage data folder 

you want to run a Task for has the information you want to monitor 

 

 

 

Task Schedule 
Many customers like the ability to send or receive information automatically. With 

MyAssistant, Tasks can be set up to run and send emails automatically on a Schedule. Every 

Task has its own Schedule, which controls the days & times a Task runs. Since Tasks run & 

emails send from the server, many companies schedule Tasks to run outside business hours 

and on weekends. 

Examples include: 

▪ On the first day of every month at 5am 

▪ Every other Wednesday at 3pm 

▪ The last Friday of every month 

▪ Every weekday at 8am  

Tip: Tasks that are set to run on a schedule can still be run manually. For example: A Task scheduled to 

send an email every Friday is manually run on Tuesday. The Task will run and send an email (if it finds 

information to send) on Tuesday, then still runs automatically on Friday. 

 

How to add a Schedule to a Task 

1. Get to the Schedule step of Task Setup.  

Note: Schedules can be added while setting up a Task or after it is activated 

2. Click the circle next to "On a schedule" 

3. Choose when you'd like the Task to run (Daily, Weekly, Monthly, etc.) 

4. Choose time & day customizations (which will change depending on what you pick) 

5. To add another schedule, click "Add another schedule" and repeat steps 3 & 4 



Copyright © 2023 Innovative Software Design 57 

 

6. Click "Next" to go the Email step of Task Setup or "OK" to close the window 

(depending on when you're adding the Schedule to the Task).  

 

Note: If a Task runs on a schedule but doesn't find anything needs to be sent (For example: 

nothing matches the Condition criteria, or nothing new needs to be sent out), emails will not 

be sent. 

 

Daily Schedule Customizations 

A "Daily" schedule lets you choose:  

▪ What time the Task runs 

▪ What days the Task will run (for example: every day, every other day, every 3 days, 

etc.) 

 

 

Weekly Schedule Customizations 

A "Weekly" schedule lets you choose: 

▪ What time the Task runs 

▪ What days of the week a Task will run 

▪ What weeks the Task will run (for example: every week, every other week, etc.) 
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Monthly Schedule Customizations 

A "Monthly" schedule lets you choose: 

▪ What time the Task runs 

▪ What day of the month the Task runs: 

▪ A specific date (for example: the 15th), or 

▪ A specific day (for example: the last Monday of the month) 

▪ Which months the Task will run 
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Email Step 
The Email step of Task Setup is where you specify who MyAssistant should email when 

information is found. It is also where you control what's in the emails that are sent, including 

any attachments. 

 

Recipients 

The Task can send emails to the recipients specified in the To, Cc and Bcc lines; or 

MyAssistant can look up who to notify based on the information found by the Task. For more 

information on recipients, click here. 

 

Email content 

Emails sent by MyAssistant Tasks most often contain a combination of one or more of the 

following: 

 

List of alerts or other items in message body 

A table in the body of an email containing one row per item being monitored by the Task 

Condition (for example: JC Job). In the Email step, you'll select the columns that appear in the 

email(s) that are sent, as well as any messaging above or below the table 
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Attached Spreadsheet 

The latest information from Sage in an easy-to-read attached Excel spreadsheet. MyAssistant 

attaches what's called a "spreadsheet template" to the Task to create the spreadsheet -- this 

is what determines the Sage information that will be included in the spreadsheet and its 

layout. A template is used so no matter how much or how little information is found, the 

appearance of the spreadsheet's content is consistent. 

 

 

 

Attached Reports 

Almost any report from a Sage reports menu can be emailed  as an attached PDF from 

MyAssistant. Report designs created with Crystal Reports can also be used to send PDFs, 

Excel spreadsheets or text files as attachments. Documents or attached reports can also be 

attached and set up so each recipient would receive only their information. 
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Send a List of Notifications 
 

Information in Sage can be sent in a list in the body of an email from MyAssistant. 

 

The following outlines the possible steps to create a list in the email. Depending on the 

desired list sent by the Task, some steps can be skipped. These steps begin in the Email step 

of Task Setup: 

 

1. Specify Columns in List: Select the columns in the emailed list by clicking & 

dragging Sage fields from the list of available information on the right side of the 

window. The list on the right contains all the information that can be accessed 

(grouped by Sage record) based on what you're sending a list of in the email. 

Columns in the list will appear as a column heading with a placeholder value (for 

example: XXXXXXX or 9999.99) in the bottom section: 

 
Click here for a table that helps identify what record information is stored in based on 

where it's viewed or entered in Sage. 

 

2. Choose Column Order: Rearrange the order of how columns will appear in the 

emailed list by clicking and dragging a column to a new place. Blue triangles indicate 

where the column will be placed. 

 
 

3. Resize Columns: Change the width of a column in the list by hovering on the right 

edge of the heading, then clicking & dragging it to the left or right: 
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4. Change the list's sort order: Change the order information appears in the list by 

clicking on a column heading. Change the sort between ascending and descending 

by clicking on the triangle that appears on the right side of the column heading

 
 

 

5. Change column headings: Change the the description at the top of a column in the 

list by double-clicking on a column heading and typing a new description: 

 
 

 

6. Group the list: Group the list by clicking and dragging a column from the list to the 

section labeled "Drag a column header here to group by that column": 

 
For example: JC Cost Codes can be grouped by Job, AP Invoices by Vendor, or AR 

Invoices by Customer. 
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7. Remove columns: Remove any unwanted columns by clicking the X under the 

column header. 

 
 

8. Add a message in the email: Add text that will appear above or below the list in the 

email by clicking above or below the text "The list defined below will be inserted here" 

and typing a message: 

 
 

9. Finish setting up the Task: When finished, click "Next" in the bottom-right of the 

window to proceed to the Options step of Task Setup. 
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Send a Spreadsheet 
Information in Sage can be sent in a spreadsheet using a MyAssistant Spreadsheet Template. 

Spreadsheet Templates define a spreadsheet's content and layout. 

 

The following outlines the possible steps to create a Spreadsheet Template. Depending on 

the desired spreadsheet(s) sent by the Task, some steps can be skipped. These steps begin in 

the Email step of Task Setup: 

1. Specify columns in spreadsheet: Select the columns that will be in the spreadsheet 

by clicking & dragging Sage fields from the list of available information on the right 

side of the window to the table at the bottom. The table will be used to create a 

spreadsheet. 

 

The list on the right side of the window contains all the information that can be 

accessed (grouped by Sage record) based on what you're sending a spreadsheet of 

attached to the email. Click here for a table that helps identify what record 

information is stored in based on where it's viewed or entered in Sage. 

 

2. Create Spreadsheet Template: Create the template MyAssistant will use to send 

spreadsheets by clicking "Spreadsheet Template" in the ribbon and selecting "Use 

Notification List" 

 

This will open a template containing the fields from the table at the bottom of the 

Email step 
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3. Resize Columns: Change the width of any column in the spreadsheet by clicking and 

dragging its right edge to the left or right  

 

4. Preview the spreadsheet: Review the spreadsheet's content, sort order and layout 

by clicking "Preview" in the ribbon 

 

5. Update the title: Change and/or move the title of the spreadsheet placed in cell A1. 

MyAssistant uses the Subject line from the Email step of Task Setup to prefill the 

spreadsheet title  

 

6. Add columns: Right-click on a column and select "Insert" to add a column to the left 

of the one selected in the Spreadsheet Template 

 

Repeat as desired to add as many columns as desired to a spreadsheet 
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7. Add information: Add any spreadsheet formulas (for example: "=D4+E4") by 

selecting a blank cell in the Repeat section (blue box labeled "Detail") and typing in a 

spreadsheet formula, or by dragging a Sage field from the list on the right into an 

open cell 

 

 

8. Set the spreadsheet's sort order: Change the order information appears in the 

spreadsheet by selecting any cell in the Repeat section, then clicking the "Sort" button 

in the ribbon. Choose how the spreadsheet will be sorted (and what information you 

can group by) in the window that opens: 

 

Click here for more information on sorting a spreadsheet 

 

9. Add rows for overlines: Right-click on the row with the Sage fields and select 

"Insert" to add a row above it that will be used for an overline
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10. Re-set the Repeat Section: Click and highlight the cells in the inserted row and the 

row below, then click "Repeat" to re-set the Repeat section 

 

 

11. Add the overline: Add an overline to the spreadsheet by selecting the cells in the 

top row of the Repeat section, clicking the "Group" button in the ribbon and 

selecting "Group Header". Choose the field you want to group by in the window that 

opens, then click OK. 

 

Click here for more information on Grouping, including Group Footers and having 

multiple groups in a spreadsheet 

12. Add information to the overline: Click and drag any Sage fields you want to add to 

the Group overline from the list on the right side of the screen

 

 

13. Add a section for grand totals: Add a section that displays at the end of the 

spreadsheet by clicking and highlight cells under the Repeat section, then clicking 

"Group" and selecting "Document Footer " 



Copyright © 2023 Innovative Software Design 68 

 

14. Add a grand total: Add a sum at the bottom of a column by clicking the blank cell in 

the Document Footer under cell that will show a number, then clicking the 

"AutoSum" button and selecting "Sum" 

 

Click here for more information on totals, including having multiple subtotals and a 

grand total in a spreadsheet 

15. Preview the spreadsheet: Confirm the content, sort order and layout of the 

spreadsheet by clicking the "Preview" button in the ribbon. Close the preview window 

using the "Close" button in the ribbon or via the "X" in the top-right of the window. 

16. Save the spreadsheet: When no other changes are needed, save the spreadsheet 

template by clicking the "Save and Close" button in the ribbon 

17. Name the Spreadsheet: Choose the name of the spreadsheet attached to the 

email(s) by accepting the default name provided, or entering a new title in the field 

18. Choose the File Type: Choose whether the attachment will be an Excel Workbook, a 

PDF, plain text or a CSV file: 

 

Click OK when finished to save the spreadsheet template to the Task 

19. Choose who should be emailed: Specify the recipients that should be sent a 

spreadsheet by typing email addresses into the "To" & "Cc" lines in the email step, or 

by adding an Email Directory to send each person their information. 

20. Finish Task Setup: When finished in the Email step, proceed to the Options step (the 

last step of Task Setup) by clicking the "Next" in the bottom-right of the window. 
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Send Reports & Documents 
MyAssistant can automatically generate and send reports and documents to recipients.  

 

The following outlines the possible steps to attach and send a report where each recipient 

gets the same information. Depending on the report(s) sent by the Task, some steps can be 

skipped. These steps begin in the Email step of Task Setup: 

1. Find the report: Identify if the report that will be attached to the Task is currently on 

a Sage Reports menu. This may in part depend on what software was used to create 

the report. 

 

2. Choose how to attach the report: If the report is already on a Reports menu in a 

Sage program, click the "Sage Report" button in the ribbon to attach the report. If the 

report was created in the Crystal Reports software and is not on a Sage Reports 

menu, click the "Crystal Report" button to attach it directly to the MyAssistant Task. 

 
 

Note: If a report was created in Sage Report Designer, it must be attached to a Sage Reports 

menu before attaching it to a MyAssistant Task. Almost any report on a Reports menu in 

Sage 300 can be attached to a MyAssistant Task.  

 

3. Select the report (Sage Report): If the "Sage Report" button was clicked, navigate 

to and select the report in the window that opens. This window shows all Sage 

reports that can be accessed, grouped by application: 
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Tip: Use the search bar at the top of the list to quickly find the desired report 

 

4. Select the report (Crystal Report): If the "Crystal Report" button was clicked, use 

the window that opens to navigate to where the report is saved on a computer. 

 
 

5. Fill out the prompts: After attaching a report to a Task, a window will open with 

several options to fill out or confirm. Start with the section labeled Report Parameters 

-- any prompts that need information to fill out the report are displayed in this 

section. Prompts can be filled in with one of three options: a specified value, 

information from a Sage field, or a MyAssistant Formula.  
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Note: A report’s content can be independent of the Task Condition -- the key is the report 

prompts and what Sage information (if any) is used to fill them out. For more information, 

see Send Each Person Their Information 

 

6. Name the attachment: Fill out the "Attachment name" section at the top of the 

window to set the name of the report or document attached to the email(s) sent by 

the Task. Click "Use Sage value in name..." to use information as part of the 

attachment name. For example: When sending each Customer their monthly 

statement, add the "Name" field from the AR Customer record to the attachment 

name. 

 

7. Choose the attachment type: Crystal Reports attached to a Task can produce a PDF, 

an Excel spreadsheet, a plain text document, or Comma Separated Values (CSV) file. 

Reports attached from Sage always create PDFs. 

 

8. Set the password: If sending a PDF, check the box and enter the same password in 

the two fields that will be required to open the document. To set a unique password 

by recipient, click the "Use Sage value for password..." button and select a field that 

has a unique value for each person who will be sent an email. For example: when 

sending each Employee their weekly pay stub, select the MyAssistant Formula "Last 4 

digits of Social Security Number" as the password. This will require each recipient to 

enter the last four digits of their SSN in order to open their pay stub 

 

Tip: Add a sentence to the message that describes their password while still being secure. For 

example: When sending pay stubs password-protected with the last four digits of the 

recipient’s Social Security Number, type "Your password is the last 4 digits of your SSN" to the 

message section in the Email step. 

 

9. Pick where to save a copy of the report: Copies of reports sent by Tasks can be 

saved to a location on a computer. Check the box to save a copy of the report, then 

choose where it will be saved. Click here for more information  

 

10. Confirm Report Settings: Review all the report options selected and information 

specified, then save changes by clicking "OK" to close the window 

 

11. Choose who should be emailed: Specify the recipients that should be sent a 

spreadsheet by typing email addresses into the "To" & "Cc" lines in the email step, or 

by adding an Email Directory to send each person their information. 

 

12. Add a message: Type a message in the middle section of the Email step that explains 

what each recipient is being sent, and any next steps recipients need to take. When 

sending each person their information, Sage fields can be added to the message to 

personalize the content by recipient. For example: When sending employees their pay 

statements, add the "Period End Date" field from the PR Check record, or the 

Employee Name from the PR Employee record.  
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Tip: Click here for a table that helps identify what record information is 

stored in based on where it's viewed or entered in Sage. 

 

13. Finish Task Setup: When finished in the Email step, proceed to the Options step (the 

last step of Task Setup) by clicking the "Next" in the bottom-right of the window. 

 

Send Each Person Their Information 
A popular use of MyAssistant is to send multiple recipients only their information with a 

single Task. Common examples include: 

▪ Weekly direct deposit pay stubs to Employees  

▪ Electronic payment notices to Vendors 

▪ Service Management invoices to Customers 

▪ Reports and spreadsheets to Project Managers containing only their jobs 

 

Keys to Sending Each Person their Information 

 

Mailing List with the Task Condition: When sending each recipient only their information, 

the Task Condition determines who should be sent an email and who shouldn't. For example: 

 Task Goal Task Condition  Mailing List That's Created 

Send employees their 

weekly pay stubs 

PR Checks from the most 

recent pay period 

Employees who got a check 

in the last pay period 

Send ACH payment notices 

to Vendors 

AP Electronic Payments in the 

last 3 days 

Vendors who were paid 

electronically in the last 3 

days 

Send Project Managers 

reports for their over-

budget Jobs 

In progress Jobs that are 

over-budget and have a 

Project Manager specified 

Only the Project Managers 

who have over-budget Jobs 

 

Email Directory to look up recipients: MyAssistant Email Directories look up email 

addresses in Sage for each item found by the Task Condition. Once MyAssistant has 

associated an email address with each item found by the Condition, it separates them into a 

separate email for each recipient. 
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To add an Email Directory to a MyAssistant Task, click the "Email Directory" button in the 

Email Step of Task Setup. Select the Email Directory you want to use, then click the button 

that matches where you want to add it (for example: the "To" line, "Cc" line, etc.): 

 
 

TIP: MyAssistant automatically filters what Email Directories are available on a Task, 

depending on where the Task is looking for email addresses and what information is being 

looked up by the Task. MyAssistant will only show Email Directories where a direct 

relationship exists. 

 

Related: Email Directories 

 

Prompts on Reports that filter the attachment's contents: When using MyAssistant to 

send attached PDFs like pay stubs, Customer statements, Job reports and more; you'll use 

prompts on the attached reports to filter the content for each email message. When you 

attach the report, change each applicable prompt so it will use the value from a Sage field -- 

this is how the report will create different content for different recipients: 

 

For example: To send each employee their pay stub, attach a report design that prompts for 

Employee ID and Period End Date. When the Report Options window opens, change the 

prompts to use Sage fields: 
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Now the report will use the Employee ID and Period End Date from the check associated with 

each email to fill out the report's prompts. 

 

IMPORTANT: Attached reports run once per email message created by the Task. If a report 

is using information from Sage to fill out report prompts and there is more than one value 

that can be used for a prompt (for example: multiple Employee checks in one email), the 

attached report will use one random value to use in the report prompt. 

 

Please note: this third key is not used when sending lists of alerts in the message body or 

spreadsheets 

 

When Set Up Correctly: 

1. The MyAssistant Task creates a mailing list based on the Condition's criteria 

2. The Email Directory on the Task associates an email address with each item found by 

the Condition 

3. Items are grouped and sorted into a separate email per recipient email address 

4. Email content is created for each recipient, including any attached reports being run 

once per email. The attached report's prompts are set up to filter its content for each 

recipient 

5. MyAssistant emails each recipient a separate message with only their information 

 

To send each recipient only their items in a list 

1. Select or create a Condition that will create a mailing list (i.e. only find information for 

the people you want to email) 

2. Create the list of alerts you want to send in the Email step of Task Setup 

3. Add an Email Directory to the Task 

When set up correctly: MyAssistant will send an email to each recipient with a list of only 

their items in the message. 

 

To send each recipient a spreadsheet of only their information 

1. Select or create a Condition that will create a mailing list (i.e. only find information for 

the people you want to email) 

2. Add the fields you want in your spreadsheet to the List Builder section in the Email 

step of Task Setup 

3. Create a Spreadsheet Template by clicking "Spreadsheet Template" and selecting 

"Use Notification List" 

 
 

4. Adjust and save the Spreadsheet Template. More information on Spreadsheets can 

be found here. 
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5. Add an Email Directory to the Task 

 
 

When set up correctly: The Task will send each recipient an email with an attached 

spreadsheet containing only their information. 

 

To send each recipient only their documents/reports 

1. Select or create a Condition that will create a mailing list (i.e. only find information for 

the people you want to email) 
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2. Attach an Email Directory to the Task in the Email step of Task Setup 

 

3. Attach a report design to the MyAssistant Task, and use Sage fields to fill out the 

report prompts in the middle of the Report Options window 
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Recipients 
A key part of MyAssistant Tasks is determining who should be sent emails. MyAssistant can 

send emails to a set list of recipients, or it can look up who to notify based on the 

information found. 

 

Set Recipient List 

To have a MyAssistant Task send emails to the same recipient(s) every time, type email 

addresses in the TO or CC fields.  

 

Tip: To type more than one email address on a line, add a semicolon (;) and a space 

between each email address 

 

Add from Address Book 

If Outlook is installed and configured on the same computer as the MyAssistant Designer, 

email addresses can be added from the Address Book to Tasks.  

 

To add email addresses from Address Book: Navigate to the Email step of Task Setup, click 

the "To" or "CC" button and choose "Select from Address Book": 

 

 

A window will open in Outlook where email addresses can be selected to add to the Task. 

This helps avoid mistyping someone's email address, and is a way to quickly add several 

email addresses at once. 

 

Email Directories 

An Email Directory tells MyAssistant what email address to use to send each recipient only 

their information. 

 

To add an Email Directory in a Task: 

1. Get to the Email step of Task Setup 

2. Under the Home tab, click the Email Directories button at the top 

3. Select the Directory you wish to notify and choose TO, CC, or BCC 
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4. Click OK 

 

 

For more information on Email Directories, click here 

 

BCC 

To add a recipient as a Bcc (which recipients added to the "To" and "Cc" lines would not see) 

click the View tab of the ribbon and click the "Bcc/Also" button. Type in email addresses in 

the field, or click the "Bcc" button to select someone from the Outlook address book. 

 

Tip: If you do not want a Task to send any emails, leave all recipient fields blank  
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Reply To 

MyAssistant features the ability to have recipients automatically reply to an email address 

different than the one that emailed them. This can be useful when MyAssistant is set up to 

send emails from one account, but the contact the recipient should reply to / contact with 

questions has a different email address. 

 

To specify a "Reply To" recipient on a Task, go to the Email Step of Task Setup. Click on the 

View tab of the ribbon and select the "Reply To" button. Type the email address of the 

"Reply To" contact in the field that appears: 

 

Now, when someone is sent an email from a Task with a "Reply To" email address, clicking 

"Reply" on the email will prefill with the address specified above. 

 

Also Notify 

When sending each recipient a Notification list or attached spreadsheet of only their 

information, one master list of all information can be sent to someone like a manager or an 

executive. This is done by specifying that person in the "Also Notify" section. 

 

To specify an "Also Notify" recipient, go to the Email Step of Task Setup. Next, click on the 

View tab of the ribbon and click "Bcc / Also". Type an email address in the "Also Notify" line 

that appears. 

 

Now, when each recipient in the Email Directory is sent a list or attached spreadsheet of only 

their information, the "Also Notify" recipient(s) will receive all the information for all 

recipients in one message. 
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Saving Copies of Emailed Attachments 
Many companies like to keep copies of the reports and documents sent with MyAssistant. 

MyAssistant can save a copy of any attached report, document or spreadsheet to a location 

on a server. 

 

When using a MyAssistant Task that uses an Email Directory and attached report prompts to 

send each recipient reports with just their information, you can save each report in a unique 

location. This enables companies to be more organized. 

 

Key Pieces 

 

Save Location: Also known as the "Save File Path", this is where you choose to save copies 

of the attachments sent by the Tasks. Since Tasks run and emails send from your server, most 

companies will choose to save copies of attachments to a location on the same machine. 

Where an attachment is saved is determined in the Report Options window after attaching a 

report to a Task: 

 
 

NOTE: If you want to save copies of attachments to a server other than the one with the 

MyAssistant Server software installed, there are a couple things to consider: 

1. The location needs to be accessible from the MyAssistant Server using what's called a 

UNC path 

2. MyAssistant sends generates and sends emails and attached reports using a process 

on your server called a Windows service (named "ISDAdminSenderService"). Every 

Windows service have to run as a Windows user, and the ISDAdminSenderService may 

need to be updated to run as a Windows user with sufficient permissions to the other 

computer. 
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Folders Created based on Sage information: To help you stay organized and keep track of 

reports you've saved, MyAssistant can create folders based on the information in Sage fields. 

For example, if you're saving a copy of each Job Cost report sent for each Job, MyAssistant 

can create folders named after the Job number or Description. 

 

 

Attachment Name:  This is what the name of the attachment will be once it's saved to a 

location on disk 

 

Tip: Add a Sage field or MyAssistant formula (for example: "Current Date" formula) to make 

the name of each attachment copy saved by the Task unique. If MyAssistant tries to save a 

copy of an attachment and finds another in the same location with the same name, it will 

overwrite the existing attachment with the new one 

 

How to save reports and documents attached with the "Sage Report" or "Crystal 

Report" options: 

 

MyAssistant can automatically create folders based on the values of Sage fields added to the 

save path. In your example, you can have MyAssistant use a unique folder for each Property. 

Here are the steps: 

1. Select your activated MyAssistant Task & click “Open” 

3. Click “Email” on the left side of the window that opens 

4. Double-click on your report design in the “Attachments” section under the Subject 

line 

5. Check the box for “Save file attachment” (or confirm it’s already checked) at the 

bottom of the window that opens 

6. Select or confirm the current path where reports are currently being saved 

7. Place your cursor at the end of the file path and press the “\” key on your keyboard 

8. Click [Use Sage value in folder name…]  

9. Choose the Sage field or MyAssistant formula you want to use to create folders and 

click “Insert”. The save file path should now look something like this: 

 
10. Repeat steps 7 & 8 if you’d like to use multiple Sage fields in the save file path  

11. Click "OK" to close the Report Options window 

12. Click "OK" to close Task Setup 
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"From" Email Address 
Companies often want to use MyAssistant to automate or work with multiple aspects of their 

business. As such, a common request is having MyAssistant send emails from different email 

addresses. With MyAssistant, you can send messages from different Email Addresses. 

 

Keys for Multiple "From" Email Addresses 

Setting up MyAssistant to use multiple emails: Part of the initial setup of MyAssistant is to 

determine what email address(es) MyAssistant will use to send emails. If MyAssistant was not 

initially set up to use multiple "From" email addresses, this can be updated in the Server 

Settings step in the MyAssistant Designer's options. 

 

Selecting a "From" Email Address in Task Setup: Once MyAssistant has been set up to use 

multiple "From" email addresses, select which one to use in the Email step of Task Setup. 

 

NOTE: If no "From" email address is specified in the Email Step of Task Setup, MyAssistant will use 

whichever email address is specified as the "Default". Changing which "From" email address is the 

default can also be done in the Server Settings step in the MyAssistant Designer's Options. 

 

To Change the "From" email on a Task 

1. Get to the Email step of the MyAssistant Task. You'll go through this step when 

initially setting up a Task, or by clicking on "Email" on the left side of the window 

when opening an already-activated Task. 

2. Click the "View" tab of the button bar at the top of the window 

3. Click the From button to add the "From" line above the "To" line 

 

4. Click the "From" button that's appeared and select the email that this Task should use 

 

5. Finish Task Setup or click "OK" in the bottom-right to save your changes  
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Send Once Per 
Sometimes information that is normally sent in one email, report or spreadsheet is easier to 

understand and work with when it's broken up into pieces. Another potential reason is that 

different parts of the information someone receives needs to be shared with different 

people. Common versions of these requests include Project Managers wanting separate 

reports for each of their Jobs, instead of one report with all of their Jobs included. 

 

MyAssistant is able to generate and send information normally in one email in separate 

messages to the same recipient(s) as the one email. When this feature is used, MyAssistant 

sends recipients a separate email for each unique value in the Sage field or MyAssistant 

formula selected. This can be used whether a Task is sending emails to a set list of recipients, 

or if it's sending each person only their information. 

 

To use the Send Once Per function: 

Select the desired Task from the main MyAssistant window and click "Open" 

Navigate to the Task Options step of Task Setup 

Check the box next to "Separate email for each" 

Choose the Sage field or MyAssistant formula to use to create separate emails from the 

dropdown 

Click "OK" to close Task Setup 

 

To turn off the Send Once Per function: 

Select the desired Task from the main MyAssistant window and click "Open" 

Navigate to the Task Options step of Task Setup 

Click the eraser icon to the right of dropdown where the Sage field or MyAssistant 

formula was selected 

Click "OK" to close Task Setup 

 

Using "Send Once Per" with Attached Reports 

When using "Send Once Per" on a Task with one or more attached Sage or Crystal Reports, 

the attached report(s) should have a prompt for the same Sage field or MyAssistant formula 

selected. This way, the report(s) attached to the emails sent will not contain the exact same 

information. 
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Message Section 
The middle section of the Email step is where messages can be written to be included in 

emails sent by the Task. 

 
 

When sending a list in the body of the email, the position of the list in the email will be 

indicated by gray text that reads "The list defined below will be inserted here". Any text typed 

above the gray text will appear above the list in the body of the email, and any text below it 

will appear below the list. 

 

To exclude the list from being included in the email, select and delete the gray text in the 

message or uncheck the "Include above list in email" checkbox at the bottom of the window. 

 



Copyright © 2023 Innovative Software Design 85 

 

Using Sage Information in the Message 

Sage fields can be added to the message of the Task in order to personalize messages sent 

to recipients. This is useful when sending each recipient only their information. 

 

To add a field to the message, click and drag a field from the Sage Field List into the 

message section. The cursor will indicate where the field will be placed. 

 
 

 

 

Task Options Step 
This step is used to set or confirm several options when setting up a MyAssistant Task. 

 

Notification Frequency 

The Sage information found by a Task are called "Notifications"; and this step controls how 

many emails recipients are sent about each Notification. The two options are: 

 

Each Time the Task Runs: Recipients receive all Notifications found by the Task every time it 

runs.  

 

For example: a Task looking at all JC Jobs finds 50 jobs, then emails you a list of all 50 Jobs. 

The Task is run again a week later and finds 52 Jobs -- you are then sent a list of 52 Jobs. 

 

Once: Recipients are emailed each Notification once. Also referred to as "Notify Once", this is 

often used when only wanting to be sent new information entered in Sage. 

 

For example: The first time a Task looking at all JC Jobs is run, it finds and sends you a list of 

50 Jobs. The following week, the Task runs again and finds 52 Jobs. This time, you are only 

sent the two new Jobs, because you were previously notified of the other 50. 

 

Reminder: Regardless of the option selected, all Notifications found by the Task will appear 

in the MyAssistant software after the Task is run. 
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Separate Email for Each / "Send Once Per" 

Sends information normally in one email in separate messages. When this feature is used, 

MyAssistant sends recipients a separate email for each unique value in the Sage field or 

MyAssistant formula selected. 

 

To implement, click the dropdown and select the Sage field or formula to use for creating 

separate emails. 

 

To clear the selection, click the eraser icon to the right of the dropdown. 

 

Tip: When using the "Send Once Per" feature, any attached reports should have a prompt 

for the same Sage field or MyAssistant formula selected. This way the attached report on 

each email will not contain the exact same information. 

 

Click here for more information on Send Once Per. 

 

Send in Daily Summary 

Tasks that send a list in an email and have no attachments can be compiled into a once-a-

day "Daily Summary" email sent to recipients. 

 

Keep Closed Notifications 

This controls whether or not MyAssistant keeps a record of the Notifications that met the 

Task's criteria on a previous run, but not the most recent run.  

 

Important: This box must be checked if you're using the "Notify Once" feature (set in 

Notification Frequency) 

 

Don't Display in Live Tile 

Some companies want multiple people to be able to run MyAssistant Tasks, but not create or 

modify them. For employees who only can run MyAssistant Tasks and send emails, 

companies can purchase licenses for the "MyAssistant Live Tile". This checkbox controls 

whether or not a Task that a company has set up can be seen or run by employees with the 

MyAssistant Live Tile.  

 

Task Name 

The name of the Task as it will appear in MyAssistant. New Task names will prefill with the 

Subject line entered in the Email step, but can be changed. 

 

Category 

MyAssistant Tasks can be placed in Categories to keep similar Tasks together and help you 

stay organized. Tasks can be placed in the existing Categories that come with MyAssistant, or 

you can create your own. 
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Subcategory 

Subcategories are used within in Categories to keep similar Tasks together to an even 

greater level of organization (for example: keeping all Tasks that have to do with HR within 

the "HR" subcategory inside the "Payroll" category. You can use existing Subcategories 

create your own in existing Categories or in Categories you create.  

 

Description 

An optional field that allows you to write a brief summary of what a Task looks for/sends and 

the intended recipients. 

 

 

 

Email Directories 
An Email Directory tells MyAssistant what email address to use to send each recipient only 

their information. This means that MyAssistant can do things like send each Project Manager 

the over-budget Cost Codes on only their jobs, send each tenant only their monthly rent 

statement, send each employee their weekly pay statement, or send each customer 

information about only their past-due invoices. 

 

How to create an Email Directory 

There are two ways to set up an Email Directory. You can enter email addresses in a field in 

Sage 300 CRE, or you can enter email addresses in the MyAssistant Email Directory setup. 

  

Option 1: Look up Email Addresses in Sage  

If you're entering email addresses in a specific location in Sage, MyAssistant can look at that 

location for its Email Directory. 

1. Start the MyAssistant Designer 

2. Click the "File" menu button and select "Email Directories" 

 

3. Click "New" in the window that opens 

4. Enter a name for the Email Directory in the window that opens. Each Email Directory 

must have a unique name. 
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5. Select "Lookup Email addresses in Sage 300 CRE" and click "Next" 

 

6. Select the Sage 300 CRE data record where the email address will be entered  

7. Select the field on the selected Sage 300 CRE record where email addresses will be 

entered 

 

Click here for a table that helps identify what record information is stored in based on 

where it's viewed or entered in Sage. 

 

8. Click View <Record Name> records missing an Email address if you would like to test 

the selected field for blanks 

9. Click Finish 

 

Option 2: Enter email addresses in MyAssistant 

1. Start MyAssistant Designer  

2. Click the "File" menu button and select "Email Directories" 

 

3. Click New  

4. Enter a name for the Email Directory in the window that opens. Each Email Directory 

must have a unique name. 
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5. Select "Lookup Email addresses in a list that you provide" and click "Next" 

  

6. Select the Sage 300 CRE data record that will be used to look up email addresses 

a. Click here for a table that helps identify what record information is stored in 

based on where it's viewed or entered in Sage. 

7. Select the Sage 300 CRE data field that will be used to look up email addresses 

8. Click "Prefill <Field Name> fields Sage 300 CRE" 

9. Select your data folder if needed then click OK 

 

 

10. For each value, type an email address or select the email address from your Outlook 

by clicking the "..." button 

11. Click View <Record Name> records missing values if you would like to test the 

selected field for blanks 

12. Click Finish 

 

Note: MyAssistant automatically filters what Email Directories are available on a Task based 

on the data relationship between where the Email Directory looks up information and what 

information the Task is monitoring. If a Task is monitoring information that doesn't have a 

direct relationship to the location where an Email Directory is looking for email addresses, 

the Email Directory can't be added to the Task. 
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Attachments 

Attached Reports 
A popular use of MyAssistant is automating the generation and sending of reports. Instead 

of having to manually run a report off a Sage Reports menu, print it and then distribute it to 

those who need it; a MyAssistant Task can automatically generate the desired report(s) and 

send them to the necessary recipients. Common examples include automatically generating 

and sending AR Aging reports, as well as creating and sending Employees their pay stubs 

every pay period. 

 

While other documents and spreadsheets can be attached to a MyAssistant Task, two 

different kinds of reports can be attached: 

Sage Reports: Reports that have been added to the "Reports" menu in a Sage 300 

application, and have been created with Sage 300's Report Designer or Crystal Reports. 

Almost any report that is on a Sage Reports menu that meets the above criteria can be 

attached to a MyAssistant Task. 

 

Crystal Reports: Reports created in the Crystal Reports software and designed to report on 

Sage 300 information can be directly attached to a MyAssistant Task. 

 

To attach a report to a Task 

1. Open or create the MyAssistant Task that will have the report attached 

2. Progress to the Email step of Task Setup 

3. Attach the (first) desired report using the corresponding button 

a. If the report is already on a Reports menu in a Sage program, click "Sage Report" 

b. If the report was created in Crystal Reports software and is not on a Sage Reports 

menu, click "Crystal Report" 

 

4. Navigate to and select the desired report 
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5. If "Sage Report" was clicked: a window will open that will list all available reports that 

can be added from Sage, grouped by application. Expand the groupings or use the 

search bar at the top to find the desired report and click "OK" 

 

 

6. If "Crystal Report" was clicked: a File Explorer window will open -- navigate to and 

select the Crystal Report that should be attached to the Task, then click "Open" 

 

After selecting which report should be attached to the Task, the Report Options window will 

open. 
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Report Options 
Sage or Crystal Reports on MyAssistant Tasks have a number of potential settings and 

options to set after they're attached. These settings control information like what information 

will be used in the report's prompts, what kind of file will be attached to an email, what the 

name of the attachment will be, and more. 

 

 
 

The Report Options window contains the following settings & options: 

Attachment Name: The name of the file(s) attached to the email(s) sent from MyAssistant.  

The values from Sage fields and MyAssistant formulas can be added to the Attachment 

Name to create personalized attachment names by recipient. This is done by clicking "Use 

Sage value in name..." and selecting the Sage field or MyAssistant formula to put in the 

Attachment Name. Examples include adding an employee's name or the period end date on 

a PR Check to the name of the pay stub employees are sent every week. 
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File Type: What kind of file the attachment(s) on the email(s) will be. If attaching a Sage 

report to a Task, the only option is PDF. 

Crystal Reports attached to MyAssistant Tasks can produce one of the following file types: 

▪ PDF 

▪ Excel Workbook 

▪ Plain Text 

▪ Comma-Separated Values (CSV) 

 

Protect PDF with Password: If the File Type is set to "PDF", a password can be set that's 

required for opening the attachment. To set a unique password for each recipient, use the 

value from a Sage field or MyAssistant Formula by clicking "Use Sage value for password..." 

 

Report Parameters: These are the prompts (if any) that are used to filter the content of the 

attached report. These prompts match the prompts seen when running the report from the 

Sage menu.  

Report parameters can be filled out with one of three possibilities: 

▪ Value: A set string of text, date or number (depending on the prompt) that does not 

change regardless of time or who the recipient is. 

▪ Sage Field: The value(s) from a specified Sage field that will be used to fill out the 

prompt. Selecting this option also requires specifying the Sage record and Sage field 

used to fill out the prompt. This option is used when sending each recipient only their 

reports or documents. Examples of using a Sage field to fill out a prompt include 

using the Employee ID off a PR Check to filter a pay stub to only that Employee. Click 

here for a table that helps identify what record information is stored in based on 

where it's viewed or entered in Sage. 

▪ Formula: MyAssistant Formulas are advanced ways to look up, calculate or 

summarize information in Sage. Selecting this option requires specifying the 

MyAssistant Formula used to fill out the prompt. The list of formulas will 

automatically filter based on the if the prompt is requiring a date, a number, or text. 

Examples include using a formula to find the last day of last month to use in  the 

"Cutoff date" prompt for a JC Cost report. 

 

Save Report Attachments: MyAssistant can save a copy of an attached report to a location 

on a server. For more information on saving copies of emailed attachments, click here. 
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Save As 
Sometimes a change needs to be made to a Crystal Report attached to a Task, but the 

original report cannot be located. The original report may not be at the path in the Report 

Properties, or there are multiple versions of the report with similar names. To ensure that the 

report currently attached to the Task gets modified, MyAssistant has the ability to save a 

copy of the Crystal Report attached to the Task to a location on disk. 

 

To save a Crystal Report attached to a Task 

1. Select the MyAssistant Task with the attached report in the main MyAssistant window  

2. Click "Open" in the button bar to open the Task 

3. Click "Email" on the left side of the window that opens to go to the Email Step 

4. Right-click on the Crystal Report in the attachments section and select "Save As..."

 

 

5. Navigate to where the report should be saved, then "Save" 

6. Click "OK" to close the Task 

 

After the saved report has been updated, it can be re-attached to the Task using the Refresh 

Report feature. 
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Report Properties 
When a report is attached to a Task, additional information about the report is stored in the 

Report Properties. This information is useful when trying to track down the original location 

a Crystal Report was added from, the date a Sage report was attached to the Task, the size of 

the attached report, and more. 

 

To view an attached report's properties: 

 Select the MyAssistant Task with the attached report in the main MyAssistant window  

1. Click "Open" in the button bar to open the Task 

2. Click "Email" on the left side of the window that opens to go to the Email Step 

3. Right-click on the Crystal Report in the attachments section and select "Properties..."

 

 

If the report was attached with the "Crystal Report" option, the following information 

appears: 

Report Name: The name of the file 

File Type: "Crystal Report" 

Source File Path: The path where the report was attached from (if found) 

Size: The size of the file on disk 

Date Attached: When the report was attached to the Task (if found) 

File Last Modified: The last time the source report was modified (if found) 

 

If the report was attached from a Sage reports menu, the following information appears: 

Report Name: The name of the report on the Sage Reports menu 

File Type: "Sage report" 

Sage Application: Which Sage 300 application has the report on its Reports menu 

Date Attached: When the report was attached to the Task 
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Refresh Report 
Crystal Reports added to a Task are stored in MyAssistant's database, so they have to be 

replaced on the Task to reflect any report changes. Instead removing the old report, re-

attaching it and re-filling out the prompts and report options, MyAssistant features the 

ability to "refresh" the attached report.  

 

Refreshing an attached report replaces the original report with a selected new one; while 

attempting to use the original's options and prompts. If the "refreshed" report has different 

prompts compared to the original report, the Report Options window opens so the prompts 

can be updated. If the new report has the same prompts as the original, the Report Options 

window will not open. In either case, the name of the report in the Attachments section of 

the Email step will update to the name of the new report (if different). 

 

To refresh a Crystal Report attached to a Task 

1. Select the MyAssistant Task with the attached report in the main MyAssistant window  

2. Click "Open" in the button bar to open the Task 

3. Click "Email" on the left side of the window that opens to go to the Email Step 

4. Right-click on the Crystal Report in the attachments section and select "Refresh..."

 

 

5. Navigate to and select the updated Crystal Report, then click "Open" 

6. (If the prompts are different) Fill out the prompts in the Report Options window that 

opens, then click "OK" 

7. Click "OK" to close the Task 
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Other Attachments 
Often times companies need to distribute attachments that aren't spreadsheets or attached 

reports. Examples include distributing blank forms that need to be filled out by employees, 

samples of documents insurance certificates that Subcontractors need to send to 

management, or sending out monthly company newsletters. These kinds of attachments can 

also be automatically sent with MyAssistant. 

 

To send non-report attachments with MyAssistant: 

Create or open the MyAssistant Task that will send the attachment 

Progress to the Email step of Task Setup 

Click "Other" in the ribbon 

Select what should be attached: 

 

 

a. Word Document: A document created in Microsoft Word 

 

b. PDF Document: An existing, accessible PDF  

 

c. Other: Any other kind file that can be accessed and attached 

 

Navigate to and select the desired attachment in the Window that opens 

Finish/Close the Task Setup 

 

Important: Any file or document attached to a MyAssistant Task using one of the above options 

will be sent as is, and contain the same information for all recipients. If needing to create and 

send reports or documents where each person gets only their information, click here 
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Spreadsheet Templates 
This reference section provides detailed explanations on the components of MyAssistant 

Spreadsheet Templates and the steps for various advanced actions that can be performed 

(for example: multiple groupings, subtotals & totals, spreadsheet formulas, and more). 

 

Spreadsheet Templates have the following parts: 

 

Spreadsheet Cells: The content of each cell can be a Sage field, MyAssistant Formula or 

Excel formula. They determine what Sage information is filled in on the spreadsheet. 

 

Repeat Section: Sets what information will be repeated for each record (for example: AP 

Vendor) found by the Task Condition 

Related: Repeat Section 

 

Sort: Controls the order records (for example: Jobs, Vendors, etc.) are listed in the 

spreadsheet, and also determines what Sage fields you can group by.  

 

Group Headers & Footers: A section that will appear at the top or bottom of a group of 

information. For example, you can group Cost Codes by Job and have an overline (Group 

Header) with the Job Name, and then have a section that subtotals amounts by Job (Group 

Footer). 

 

Document Headers & Footers: Appear once at the beginning or end of the spreadsheet. 

Document Headers are often used for information like column headings and spreadsheet 

titles, while Document Footers are used for things like grand totals. 

 

 

How to add a Spreadsheet Template to a Task 

1. Open a prebuilt or create a new Task and advance to the Email step of Task Setup 

2. Click the "Spreadsheet Template" button in the ribbon 

 
 

3. Choose how the template should be created: 

▪ Choose "New" to start with a blank or prebuilt Spreadsheet Template 

▪ Choose "Use Notification List" to use the list of Notifications at the bottom of 

the Email step to create a template 
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How to add a Spreadsheet Template to a Task 

1. Open a Task with a template attached and advance to the Email step of Task Setup 

2. Right click on the Spreadsheet Template in the "Attachments" section under the 

Subject line 

3. Select "Remove" 

 
 

 

Note: Only one MyAssistant Spreadsheet Template can be attached to a Task at a time. Each 

recipient on a Task can be sent a spreadsheet with only their information, but every 

spreadsheet will use the same Spreadsheet Template. 
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Repeat Section 
The Repeat Section of a Spreadsheet Template controls what information is repeated for 

each Sage record found by the Task Condition. The Repeat Section can be identified by the 

blue box and the "Detail" label: 

 

 
 

Information must be inside the repeat section to be repeated for every record found by the 

Task Condition. 

 

 

Tip: Include blank rows in the Repeat Section (above and below the row with Sage 

information) if information will be grouped in the spreadsheet. Any group headers/footers in 

the spreadsheet template are added inside the Repeat section 

 

To set or change a Repeat Section on a Spreadsheet Template: 

1. Open the MyAssistant Task: Select the Task sending a spreadsheet, then click the 

"Open" button in the ribbon 

2. Open the Spreadsheet Template: Click "Email" on the left side of the step that 

opens, then right-click on the spreadsheet template in the "Attachments" section and 

select "Edit Spreadsheet" 
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3. Insert row(s) for overline(s): Right-click on the row with the Sage fields and select 

"Insert" to add an overline that will be used for a group header. Repeat for as many 

groups with overlines as desired in the spreadsheet. 

 
 

4. Insert row(s) for subtotals: Right-click on the row below the row with the Sage 

fields and select "Insert" to add a row that will be used for subtotals in a group footer 

 
 

Tip: Add two rows to the bottom of a Repeat Section for each Group Footer that will be 

eventually added. When setting a group footer that will include subtotals, the final 

spreadsheet will include a blank row that separates the groups and makes it easier to read 
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5. Re-set the Repeat Section: Click and highlight the cells the original and all inserted 

rows, then click "Repeat" to re-establish the Repeat section. 

 
 

Note: Re-sizing a Repeat Section using the above steps preserves the Sort order of the 

spreadsheet (if previously set). 

 

After the Repeat Section is established, the Sort will set the order information appears in the 

spreadsheet; as well as what groupings can be set in the spreadsheet template  

 

Sort 
The Sort on a Spreadsheet Template controls the order Sage information (for example: Jobs, 

Vendors, etc.) is listed in the spreadsheet, as well as how information can be grouped. 

 

A Sort order can only be specified on a spreadsheet template after a Repeat Section has 

been added to a Spreadsheet Template. 

 

The dropdown list of available fields to sort a spreadsheet template will always prefill with 

the Sage fields that have already been added to a Spreadsheet Template. Sage fields not in 

the spreadsheet template can be used by selecting "More Fields..." at the bottom of the 

dropdown. 

 

This outlines the steps to update the Sort of a spreadsheet Template. Depending on the 

spreadsheet(s) being sent by the Task, some steps may be skipped. These steps begin after 

opening the Spreadsheet Template in the Email Step of Task Setup: 

 

1. Open the Sort window: Click on a cell in the Repeat section, then click the Sort 

button in the ribbon 
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2. Remove sorts: Click the X to remove any fields or formulas being used to sort the 

Spreadsheet.  

 
Removing a sort also removes any linked Group Headers or Footers 

 

3. Add new sort fields: Click the "[None]" dropdown at the bottom of the list and 

select a field to add a new sort. Repeat with the new blank dropdown at the bottom 

of the list to add any further new sorts. 

4. Change the Sort order: Use the up & down arrows and the "Ascending" & 

"Descending" options for each row to rearrange the Sort order of the Spreadsheet 

Template 

 
 

5. Click "OK" when finished 

 

Note: After changing the Sort order, any Group Headers & Group Footers already in the 

spreadsheet will automatically update based on the new Sort.  

 

For example: If a spreadsheet of Subcontracts previously sorted & grouped by Project 

Manager and Job were changed to sort by Job and Vendor, the group headers and footers 

in the template would automatically update to group the spreadsheet by Job and Vendor. 
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Grouping Data 
Spreadsheet Templates can group information based on specified values (for example: 

grouping Cost Codes by Job number, AP Invoices by Vendor, etc.) using Group Headers and 

Footers.  

 

Group Headers and Footers are placed in a Spreadsheet Template as complete rows at the 

top and bottom (respectively) of the Repeat Section.  

 

Spreadsheets can only be grouped by Sage fields or Formulas that have been added to the 

Sort of the spreadsheet. 

 

 

Add Group Headers 

Group Headers appear at the top of a group of information in a spreadsheet as an overline 

that identifies the group of information to follow (for example: Cost Codes grouped by Job 

could have an overline over each Job's Cost Codes with the Job number and description. 

When grouping by multiple fields, sometimes multiple overlines are needed. 

 

This outlines the steps to add one or more Group Headers to a Spreadsheet Template. 

Depending on the spreadsheet that will be sent, some steps may be skipped. These steps 

begin after opening the Spreadsheet Template in the Email Step of Task Setup: 

 

1. Insert row(s) for the Group Header(s): Right-click on the row in the Repeat Section 

with the Sage fields and select "Insert" -- this will add overline that will be used for a 

group header. Repeat for as many overlines as desired in the spreadsheet. 
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2. Re-set the Repeat Section: Update the Repeat Section to include the rows added. 

The Group Headers that will be added to the spreadsheet will be inside the Repeat 

Section. 

 
 

 

3. Set the first Group Header: Select all the cells in the row at the top of the Repeat 

section, click then Group and select Group Header.  

 
 

4. Assign the first Group Header: Choose the top field in the list of fields that opens, 

then click OK. This will set the overline and group the information in the spreadsheet 

by that field 

 
 

Note: Group headers must be added from top-to-bottom in the order they appear in the 

Sort, even though a spreadsheet does not have to include a group for every Sort. For 

example: If a spreadsheet of JC Categories was being sorted by Job, Extra and Cost Code; 

the spreadsheet could be grouped by Job, then Cost Code -- but not by Cost Code, then 

Job. 
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5. Set the second Group Header(s): Select the next row at the top of the Repeat 

Section, click "Group" and select "Group Header" again 

 
 

6. Assign the second Group Header: Choose the next field in the list of fields that 

opens, then click OK. This will set the second overline under the first and group the 

information in the spreadsheet by that field 

 
 

7. Add information to the Group Headers: Add the Sage fields and other information 

that should be displayed at the top of each group to the spreadsheet. 

 

Repeat the above steps as desired for as many Group Headers that should be included in the 

Spreadsheet Template. 

 

 

Add Group Footers 

Group Footers appear as a row (or rows) at the bottom of a group of information in a 

spreadsheet to denote the end of the group (for example: Cost Codes grouped by Job could 

have line at the bottom of group before the start of the next Job's Cost Codes). When 

grouping by multiple fields, sometimes multiple footers are needed (especially when 

including multiple subtotals. 

 

This outlines the steps to add one or more Group Footers to a Spreadsheet Template. 

Depending on the spreadsheet that will be sent, some steps may be skipped. These steps 

begin after opening the Spreadsheet Template in the Email Step of Task Setup: 
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1. Insert row(s) for the Group Footer(s): Right-click on the row below the row in the 

Repeat Section with the Sage fields and select "Insert" -- this will add a row that will 

be used for a group footer. Repeat for as many group footers as desired in the 

spreadsheet.

 
 

Tip: If adding subtotals to a spreadsheet, insert two rows for each group footer. This will 

allow for a row with the group subtotals, then still include a blank row to separate the 

groups. 

  

2. Resize the Repeat section: Expand the Repeat section for including Group Footers 

by clicking & selecting the entire Repeat section, plus the blank rows under the 

Repeat section. Click the "Repeat" button in the ribbon to resize the Repeat section 
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3. Set the first Group Footer: Select the cells in the bottom two row at the bottom of 

the Repeat section, then click "Group" and select "Group Footer".  

 
 

4. Assign the first Group Footer: Choose the same field that was selected for the 

topmost Group Header in the template, then click "OK". This will set the section that 

separates each group of information from the next 

 
 

Note: Group Footers must be added from bottom-to-top, mirroring the order of the Group 

Headers in the spreadsheet. For example: If a spreadsheet of JC Categories was being sorted 

by Job, Extra and Cost Code; the lowest Group Footer would be Job, then Extra (if grouped 

by it), then Cost Code. 

 

5. Set the next Group Footer: Select the next row(s) of cells at the bottom of the 

Repeat Section (above the first Group Footer), then click "Group" and select "Group 

Footer". 
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6. Assign the next Group Footer: Choose the same field that was selected for the 

second Group Header in the template, then click "OK". This will set the second 

grouping inside the first grouping 

 
  

7. Add information to the Group Footers: Add information like Totals that should be 

displayed at the top of each group to the spreadsheet. 

 

Repeat the above steps as desired for as many Group Footers that should be included in the 

Spreadsheet Template. 

 

 

Remove a Group Header or Footer 

Sometimes a spreadsheet contains more group headers or footers than desired. This outlines 

the steps to remove a Group Header or Footer from a Spreadsheet Template. These steps 

begin after opening the Spreadsheet Template in the Email Step of Task Setup: 

 

1. Select the Group Header or Footer: Click and drag to highlight all the cells in the 

Group Header or Footer that needs to be removed 

 

2. Remove the Header or Footer: Click the "Remove Section" button to remove the 

Header or Footer. If a spreadsheet has neither a Group Header or Footer for a specific 

Sage field, the spreadsheet will no longer be grouped by that field (for example: If a 

spreadsheet of Categories being grouped by Job and Cost Code has the "Cost Code" 

Group Header and Group Footer removed, the spreadsheet will no longer be 

grouped by Cost Code). 
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3. Remove the extra row(s): Right-click on the row heading that previously held the 

Group Header or Footer and select "Delete" -- this will remove an extra row from 

being repeated for every item in the spreadsheet. Repeat as needed for additional 

rows removed 

 
 

Repeat as needed to remove any other Group Headers or Footers from the Spreadsheet 

Template. 

 

 

Document Headers & Footers 
Document Headers & Footers are optional sections that appear once at the beginning and 

end of a spreadsheet, respectively.  

 

While Group Headers and Group Footers are added to a spreadsheet inside the Repeat 

Section, Document Headers & Footers must be added outside the Repeat Section. 

 

Document Headers 

Document Headers can include the name of the spreadsheet, column headings, the date the 

spreadsheet was run, and any Sage information that applies to all the information in the 

spreadsheet (for example: if sending a separate spreadsheet of Cost Codes by Job, the JC Job 

Number and Description could be added to the Document Header). 
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To add a Document Header 

These steps assume the Spreadsheet Template does not have an existing Document Header, 

and begin after opening the Spreadsheet Template in the Email step of Task Setup: 

 

1. Add rows to the top of the Spreadsheet: Right click on the row header for the first 

row in the spreadsheet and select "Insert". This will add rows to the top of the 

spreadsheet that will be used for the Document Header. Repeat to add as many rows 

as desired to the top of the template: 

 
 

2. Add information: Type in column headings and add any information that will print 

once at the top of the Document Header (for example: title of the spreadsheet, date 

the spreadsheet is being created, etc.) 

 

3. Set the Header: Click and drag the mouse to highlight the cells above the Repeat 

Section that will make up the Document Header, then click the "Group" button in the 

ribbon and select "Document Header" 

 
 

Note: Only cells above the Repeat Section can be used to create a Document Header that 

will print correctly. Also, if any cells inside the Repeat Section are included in the selection, a 

Document Header cannot be set. 
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To remove a Document Header 

If a Document Header already exists in a Spreadsheet Template and needs to be removed, 

select a cell anywhere in the Document Header and click the "Remove Section" button in the 

ribbon: 

 
 

Document Footers 

Document Footers are often used for totals or any information that should be displayed once 

at the bottom of the spreadsheet (for example: if sending a separate spreadsheet of Cost 

Codes by Job, the JC Job Description could be added as a label for the grand totals in 

Document Footer). 

 

To add a Document Footer 

These steps assume the Spreadsheet Template does not have an existing Document Footer, 

and begin after opening the Spreadsheet Template in the Email step of Task Setup: 

 

1. Add information under the Repeat Section: Add any totals or other information 

that should print once at the bottom of the spreadsheet 

 

2. Set Document Footer section: Click and drag the mouse to highlight the cells below 

the Repeat Section that will make up the Document Footer; then click the "Group" 

button in the ribbon and select "Document Footer" 

 
 

Note: Only cells below the Repeat Section can be used to create a Document Footer that 

will print correctly. Also, if any cells inside the Repeat Section are included in the selection, a 

Document Footer cannot be set. 
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To remove a Document Footer 

If a Document Footer already exists in a Spreadsheet Template and needs to be removed, 

select a cell anywhere in the Document Footer and click the "Remove Section" button in the 

ribbon. 

 
 

 

Totals 
Amount fields can be totaled in spreadsheets sent by MyAssistant, including having multiple 

totals for a column (for example: subtotals by group and a grand total at the bottom of the 

spreadsheet). Since MyAssistant uses Spreadsheet Templates and the number of rows in a 

spreadsheet can change between Task runs, a special function must be used. 

 

The following outlines the possible steps to add totals to a Spreadsheet Template. 

Depending on the desired spreadsheet(s) sent by the Task, some steps can be skipped. These 

steps begin after opening the Spreadsheet Template in the email step of Task Setup: 

 

1. Add the first total: Select the cell with the amount that will be totaled, then click the 

"AutoSum" button in the ribbon and select "Sum". This will add the formula needed 

to create a sum under the amount field: 

 
This formula is designed so that no matter how many rows appear in the Repeat 

Section, every time the Task runs the sum will be correct. 
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2. Highlight the cells for the second total: Click and drag the mouse to highlight the 

original amount field, the previous sum, and any rows between the amount field and 

where the second amount will go. 

 
The rows between the amount and where the second total will go need to be 

included to ensure that all amount fields are correctly considered when creating the 

next sum 

 

3. Create and move the second total: Click on the cell with the new total, then hover 

on the edge and drag it down to the correct position in the next group 

footer/document footer.
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4. Adjust the second total: Double-click in the second total field and add "/2" to the 

end of the formula. 

 
This is needed because the range of cells being calculated for the second total will be 

double what the number should be. This is the result of summing the original amount 

field and the first total -- all in the same column. 

 

Important: Whatever number a Total is in a single column in the spreadsheet, add 

"/*number*" to the end of the Sum formula.  

 

For example: A spreadsheet has a list of Subcontracts that are grouped by Job and Vendor. 

The spreadsheet has a column where the Subcontract Amount is being totaled by Job, then 

Vendor, and finally a grand total at the end of the spreadsheet. For accurate totals, the 

Vendor total will need to be divided by 2, and the grand total will need to be divided by 3. 

 

Repeat the above steps as needed to add as many totals as desired to a Spreadsheet 

Template 
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Prebuilt Spreadsheet Templates 
MyAssistant contains several prebuilt Spreadsheet Templates that can be attached to a Task. 

A Prebuilt template can be used instead of creating a template from the Notification List in 

the Email step -- this saves time while providing the desired information. 

 

Tip: Type "Spreadsheet" into the search on the main MyAssistant window (when viewing all 

Tasks) to see prebuilt MyAssistant Tasks with Spreadsheet Templates already attached 

 

Every Spreadsheet Template gets linked to Sage record based on what the Task is set to 

send a Spreadsheet of when the template is created. As such, not all prebuilt templates are 

available on all Tasks. 

 

Available Templates 

The following list outlines all prebuilt Spreadsheet Templates available in MyAssistant, as well 

as what each template creates a spreadsheet of: 

 

Spreadsheet Template Creates a Spreadsheet of 

AP Cash Flow by Vendor AP Invoices 

AP Invoice Register by Job AP Invoices 

AP Vendor Payments by Job AP Invoice Distribution Payments 

AR Aging by Job AR Invoices (i.e. AR Status) 

AR Aging Detail by Job AR Invoices & Cash Receipts (i.e. AR Activity) 

Cost Entries by Job JC Transactions 

JC Cost Breakdown JC Categories 

JC Cost to Complete JC Cost Codes 

RFI Log PJ RFIs 

SM Agreements SM Agreements 

Vendor Insurance by Job 
JC Subcontracts and Purchase Orders (i.e. JC 

Commitments) 

WIP Spreadsheet JC Jobs 

 

To attach a prebuilt Spreadsheet Template to a Task: 

1. Create a new Task or activate a prebuilt Task and advance to the Email step of Task 

Setup 

2. Click "Spreadsheet Template" and select "New" 
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3. Select a Template: Choose a template from the list and click OK 

 
 

Reminder: The list of available Prebuilt Spreadsheet Templates will vary based on what was 

selected in the "Spreadsheet of" dropdown in the "What to Send" step of Task Setup. 

 

To remove a prebuilt Spreadsheet Template from a Task: 

1. Select the Task sending the Spreadsheet Template in the main MyAssistant window 

and click "Open" in the ribbon 

2. Advance to the Email step of Task Seup 

3. Right-click on the Spreadsheet Template in the attachments section (under the 

Subject line) and click "Remove" 
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Security 
MyAssistant send spreadsheets that can require a password in order to be opened, and can 

require a separate password in order to make changes. 

 

The following outlines the possible steps to add passwords for opening and editing a 

Spreadsheet Template. Depending on the desired level of security for the spreadsheet(s) sent 

by the Task, some steps can be skipped. These steps begin in the Email step of Task Setup: 

1. Open the Spreadsheet Template: Right-click on the Spreadsheet Template in the 

"Attachments" section under the Subject line and select "Edit Spreadsheet" 

 
 

2. Open the Security Settings: Click the "Review" tab of the ribbon in the window that 

opens, then click "Protect Spreadsheet" 

 
 

3. Set a password to open the Spreadsheet: Check "Require a password to open the 

document" and enter a password in the specified fields 
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4. Set a password to edit the Spreadsheet: Check "Require a password to edit 

content" and enter a password in the specified fields (this does can be a separate 

password than the one for opening the spreadsheet) 

 

5. Set any exclusions: Check the box for each activity that can be done without 

entering the password required to edit content. Options include inserting and 

deleting columns and rows; and more. 

 
 

6. Save the Template: Click OK to close the window, then click the "Home" of the 

ribbon and select "Save and Close" to close the template 
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Import & Export Spreadsheet Templates 
MyAssistant features the ability to import and export Spreadsheet Templates from Tasks. 

Exporting a spreadsheet template can be useful when needing assistance or having a change 

made by someone outside the office. Importing a Spreadsheet Template allows for quickly 

updating or setting up a new spreadsheet on a Task. 

 

To Export a Spreadsheet Template: 

1. Select the MyAssistant Task with the attached spreadsheet in the main MyAssistant 

window  

2. Click "Open" in the button bar to open the Task 

3. Click "Email" on the left side of the window that opens to go to the Email Step 

4. Right-click on the Spreadsheet Template in the attachments section and select "Save 

As..." 

 

 

5. Navigate to where the Spreadsheet Template should be saved, then click "Save" 

6. Click "OK" to close the Task 

 

To Import a Spreadsheet Template: 

1. Select the MyAssistant Task with the attached spreadsheet in the main MyAssistant 

window  

2. Click "Open" in the button bar to open the Task 

3. Click "Email" on the left side of the window that opens to go to the Email Step 
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4. If a Spreadsheet Template is already attached, right-click on the template and select 

"Edit Spreadsheet" 

 

 

5. If a Spreadsheet Template is not on the Task, click "Spreadsheet Template" in the 

ribbon and select "Use Notification List" 

 

 

6. Click the "Review" tab of the ribbon in the window that opens, then click "Import" in 

the ribbon 

 

 

7.  Navigate to and select the Spreadsheet Template that should be imported, then click 

"Open" 

8. Click the "Home" tab of the ribbon, then click "Save and Close" 
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Saving Copies of Spreadsheets 
MyAssistant can save a copy of any attached report, document or spreadsheet created from 

a Spreadsheet Template to a location on a server. 

 

When using a MyAssistant Task that uses an Email Directory and attached report prompts to 

send each recipient reports with just their information, each report can be saved in a unique 

location. This enables companies to be more organized. 

 

MyAssistant can also automatically create folders based on the values of Sage fields added 

to the save path. For example, MyAssistant can create a unique folder for each Job, 

Customer, Employee, etc.  

 

How to Save Attachments Created with MyAssistant Spreadsheet Templates: 

1. Select the activated MyAssistant Task & click “Open” 

2. Click “Email” on the left side of the window that opens 

3. Double-click on the spreadsheet template in the Attachments section under the 

Subject Line 

4. Click the "Page Layout" tab of the ribbon and click "Rename Workbook" 

5. In the window that opens, choose what form you  select the path where you want to 

save copies of the spreadsheet(s) sent by the Task

 
 

  

Note: Attachments created from a Spreadsheet Template can be saved as a file type other than 

Excel Workbook. Spreadsheet Templates can also create PDFs, plain text files, or CSV documents. 
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Settings 
MyAssistant has two parts: the MyAssistant Server software and the MyAssistant 

workstation(s). After installing and configuring the MyAssistant Server software, the next 

thing that will be installed will be MyAssistant on any workstations where it will be used. 

 

After a MyAssistant workstation has been installed, it will need to be configured -- this 

section covers the steps involved in configuring a MyAssistant workstation, as well as the 

information that can be updated afterwards from within a MyAssistant Designer. 

 

Configuring a MyAssistant workstation involves the following steps: 

1. Activate the MyAssistant workstation license (either MyAssistant Designer or 

MyAssistant) 

2. Enter the Sage user name and password MyAssistant will use for local processes (for 

example: browsing data) 

3. Enter information about yourself  

 

Reviewing the above items and more after configuring a MyAssistant Designer can be done 

by opening the MyAssistant Designer, clicking "File" and selecting "Options": 
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Activating MyAssistant 
MyAssistant workstations must be activated to use the software. Each MyAssistant 

workstation is tied to a Windows user on a computer. Make sure that you are logged in as 

the Windows User who will use MyAssistant prior to activation. This may not the same as the 

Windows account used to install the MyAssistant workstation. 

 

 
 

MyAssistant product keys are available in the Sage Customer Portal where you get your Sage 

product keys.  

 

Enter the following information in their respective fields: 

 

▪ Customer Number: Sage customer number assigned to your company. This can be 

found in the Sage Customer Portal, or by opening a Sage 300 application, clicking the 

Help menu button and selecting "About [Application Name]" 

▪ Product Key: MyAssistant Workstation product key. This will be one of two licenses:  

MyAssistant Designer – The full version of MyAssistant. The MyAssistant 

Designer provides the ability to create, activate and change Tasks; as well as 

run Tasks and view what was found. 

 

MyAssistant – MyAssistant has the ability to run MyAssistant Tasks on 

demand and view what was found.  
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Sage 300 Data Folders 
This step controls what Sage user MyAssistant will use locally, and confirm the data folder(s) 

MyAssistant will monitor:  

 

 
 

Specify Sage 300 CRE data folder locations 

The data folders specified during the MyAssistant Server Configuration will be listed in the 

grid. Click in the grid to select any data folder paths that do not prefill.  

 

Check the "Ignore" checkbox for any Sage 300 CRE data folders that should not be accessed 

on this workstation.  

 

Sage 300 CRE User and Password  

Enter the Sage User & password for the person using MyAssistant. This will be used to: 

▪ Access Sage 300 CRE reports that can be attached to Tasks 

▪ Test Task Conditions 

▪ Test MyAssistant Formulas 

▪ Preview MyAssistant Spreadsheet Templates 
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Server Settings 
This controls a variety of MyAssistant Server settings that can be updated from the 

MyAssistant Designer. 

 

 
  

Note: This step is only available in the MyAssistant Designer by clicking the File menu 

option, selecting "Options" and clicking on "Server Settings" in the window that opens. It will 

not be a step when configuring a MyAssistant workstation. 

 

Sage User & Password 

In order to monitor information in Sage, MyAssistant needs a user and password in order to 

access that information. To do that, you'll enter the following information in the specified 

fields: 

 

▪ Sage 300 CRE User – Enter the Sage 300 CRE user MyAssistant will use to access 

Sage information  

▪ Sage 300 CRE password – Enter the password associated with the Sage user entered 

 

This Sage user & password is different than what's entered in the Sage 300 Data Folders step 

in that this is the user & password that will be used to run Tasks and access information on 

the server.  

 

Important: Best practices are to use a Sage 300 CRE user with a password that does not 

expire. Also, using an Application Administrator-level Sage user ensures MyAssistant has 

sufficient access to all the Sage information you want it to monitor. 
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Import Sage Database Customizations  

MyAssistant automatically imports custom fields and descriptions when monitoring one Sage 

data folder. If MyAssistant is monitoring multiple folders, you will be prompted to select 

which folder’s customizations to import. 

 

Note: Only one Sage folder’s custom fields & descriptions can be in MyAssistant at a time. 

Importing another Sage data folder’s customizations will overwrite previous Sage 

customizations in MyAssistant. 

  

When you create a new custom field or change a field’s description in Sage 300 CRE, you 

must re-run the import process for MyAssistant to recognize the change. 

 

 

Email Settings 

This section lets you update the information MyAssistant needs to send email messages (i.e. 

the outgoing mail server information and/or the "From" email addresses). 

 

Mail Server Settings 

This is the information that must be the same for all email accounts MyAssistant sends 

emails from: 

▪ Outgoing Email Server – Confirm your outgoing server name with your IT/mail 

server administrator 

▪ Outgoing Email Server Port – The port used if the outgoing email server requires a 

port other than 25 

▪ "Use an SSL/TLS connection" checkbox – will be checked if your email server 

requires a secure connection (for example: a password is required in the grid below) 

 

From Email Account(s) 

These are the accounts MyAssistant will send emails from when running Tasks. This section 

allows you to review & update: 

▪ Default Checkbox – This controls which account MyAssistant sends emails from 

when a "From" email address isn't specified on a Task. 

▪ From Name – This name is displayed in the recipient’s inbox 

▪ Email Address  

▪ User Name – In most cases the user name is the email address. Confirm with your 

email server administrator 

▪ Password 

 

Send Errors To 

Should an error occur and MyAssistant is able to send an email about it, it will send a 

message to the person specified in this section. Best practice is to send error messages to 

whoever has the MyAssistant Designer. 
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Your Settings 
This step is for entering information about the person using MyAssistant & what additional 

options, if any, they would like to enable. 

 

As part of the configuration you will fill out the following fields: 

▪ Your Name - The name of the person using MyAssistant 

▪ Your Email Address - Your email address 

 

You'll also check or uncheck boxes for a number of additional settings: 

▪ Show Notifications in the Sage 300 Desktop – Controls if activated MyAssistant 

Tasks and their results (called "Notifications") appear in the Sage Desktop software in 

the Applications list 

 

▪ Display MyAssistant Alerts in the System Tray – Controls if MyAssistant appears in 

the Windows System Tray (i.e. the bottom-right section of the Windows task bar next 

to the current date and time) 

 

▪ Show MyAssistant Tile on the Desktop – Controls if the "MyAssistant Live Tile" 

appears on your Windows desktop. The Live Tile is a way to quickly look up 

information in Sage and run Tasks not on schedules without having to open the full 

MyAssistant software. 

 

▪ Send me ideas on using MyAssistant – Controls if you are emailed (at the address 

specified above) new ideas on how to use MyAssistant.  

  



Copyright © 2023 Innovative Software Design 129 

 

MyAssistant Server Configuration 

MyAssistant has two parts: the MyAssistant Server software and the MyAssistant 

workstation(s). When initially setting up MyAssistant, the first thing installed will be the 

MyAssistant Server software.  

 

After the MyAssistant Server has been installed, it will need to be configured -- this section 

covers the steps involved in configuring the MyAssistant Server for the first time, as well as 

what can be changed after the initial configuration. 

 

Configuring the MyAssistant Server involves the following steps: 

1. Activate the MyAssistant Server 

2. Select which prebuilt “Tasks” (Construction or Real Estate) to use in MyAssistant 

3. Enter the Sage user name and password MyAssistant will use to access Sage 300 CRE 

data 

4. Choose which Sage 300 CRE data folders MyAssistant will monitor 

5. Enter the email address(es) MyAssistant will use to send emails 

6. Specify MyAssistant Server settings 

 

When you configure the MyAssistant Server, you'll start on a "Welcome" screen with a couple 

reminders of what you'll need and an option to show the Advanced Options. 
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MyAssistant Server Activation 

This step covers activating the MyAssistant Software and any Web Proxy Settings that will be 

used. In this step, you will enter the following information in their respective fields: 

▪ Customer Number: Sage customer number assigned to your company. This can be 

found in the Sage Customer Portal, or by opening a Sage 300 application, clicking the 

"Help" menu button and selecting "About [Application Name]" 

 

▪ Product Key: The product key for activating the MyAssistant Server. This is the only 

place the MyAssistant Server product key will be entered. 

  

 

 
 

 

When configuring the MyAssistant Server, click "Activate" after entering the above 

information. Click "Next" when you see a message on the screen that the software is 

activated. 

  

 

Note: The Web Proxy Server checkbox will only appear if you selected Show Advanced 

Options in the Welcome step. If you use a Web Proxy Server, check the box displayed under 

the Server Product Key field and provide the requested information. 
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MyAssistant Database Connection 
MyAssistant stores information about your Tasks, Task schedules, Email Directory 

information, copies of attached Crystal Reports and more in its own database. This database 

exists in a type of software called Microsoft SQL Server. This step of the Server Configuration 

is where you name the server where the SQL instance exists, the name of the SQL Server 

instance, and what port number should be used to connect to the database.  

 

If MyAssistant is using the SQL Server instance that is installed as part of a normal 

MyAssistant installation, this information will be prefilled and the step will be skipped in the 

initial MyAssistant Server Configuration. 

 

If the "Show Advanced Options" checkbox is checked on the first step of the MyAssistant 

Server Configuration, or you're using a different instance of SQL Server, you will need to 

confirm/enter the information required in this step. 

 

 
 

 

 

Warning: It is strongly recommended that the information in this step is not changed. Changing any 

information could break the connection between the MyAssistant software and its database. 
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MyAssistant Database 
When initially setting up MyAssistant, you will have the option to select which prebuilt 

MyAssistant Tasks should be set up. It's recommended you choose based on your business 

and what you primarily want to use MyAssistant for, as this selection is permanent and 

cannot be changed.  

  

Check the Documents folder in the MyAssistant install files to see what Tasks are set up with 

each selection.  

 

 
 

Note: This step will only appear when configuring the MyAssistant Server and creating a 

MyAssistant database for the first time. 

 

Click "Next" at the bottom of the window after selecting your prebuilt Tasks. MyAssistant will 

then begin creating its database and advance to the next step when it is ready. 

 

 

Sage Login and Data Folders 
MyAssistant can monitor and automatically report on multiple Sage data folders, or just one. 

In this step you select which data folders MyAssistant will monitor, as well as the Sage user 

and password MyAssistant will use to access that information. 
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Sage User & Password 

In order to monitor information in Sage, MyAssistant needs a user and password in order to 

access that information. To do that, you'll enter the following information in the specified 

fields: 

 

▪ Sage 300 CRE User – Enter the Sage 300 CRE user MyAssistant will use to access 

Sage information  

▪ Sage 300 CRE password – Enter the password associated with the Sage user entered 

  

Important: Best practices are to use a Sage 300 CRE user with a password that does not 

expire. Also, using an Application Administrator-level Sage user ensures MyAssistant has 

sufficient access to all the Sage information you want it to monitor. 

 

If the need should arise, the Sage user & password information can be updated from the 

MyAssistant Designer. To update: open the MyAssistant Designer, click the "File" menu 

button, click on "Options", then select "Server Settings" on the left side of the window that 

opens. 

  

Sage Data Folders  

This controls which Sage data folders MyAssistant can monitor. MyAssistant can only run 

Tasks for data folders in this list. When configuring the MyAssistant Server: Click "Add 

Folder" and select the first Sage Data folder you want to monitor. Repeat as desired until all 

Sage data folders are added.  

 

Note: If the MyAssistant Server is not on the same computer as the Sage 300 CRE Server, 

make sure the data folder paths are UNC paths (i.e. the paths begin with "\\") and do not 

use mapped drives. 

 

If you need to change which Sage data folders MyAssistant is monitoring after the initial 

configuration, open the MyAssistant Configuration Manager on the server to change the 

data folders being monitored. 

 

Import Sage Customizations  

MyAssistant automatically imports custom fields and descriptions when monitoring one Sage 

data folder. If MyAssistant is monitoring multiple folders, you will be prompted to select 

which folder’s customizations to import.  

 

Note: Only one Sage folder’s custom fields & descriptions can be in MyAssistant at a time. 

Importing another Sage data folder’s customizations will overwrite previous Sage 

customizations in MyAssistant. 

  

When you create a new custom field or change a field’s description in Sage 300 CRE, you 

must re-run the import process for MyAssistant to recognize the change. This can be done 

from inside the MyAssistant Designer by opening MyAssistant, clicking the "File" menu 

button, clicking on "Options" and selecting "Server Settings" on the left side of the window 

that opens. 
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Email Accounts 
MyAssistant communicates information by sending emails. This step covers the information 

MyAssistant needs to send messages from the desired email account(s).  

 

Note: If this information is not available when configuring the MyAssistant server, you can 

enter it later in the MyAssistant Designer. To update: open the MyAssistant Designer, click 

the "File" menu button, click on "Options", and select "Server Settings" on the left side of the 

window that opens. 

 

 
 

Outgoing Mail Server 

The following mail server information must be the same for all email addresses that 

MyAssistant will use to send emails: 

▪ Outgoing Email Server – Confirm your outgoing server name with your IT/mail 

server administrator. All email addresses entered in this step must use the same 

outgoing mail server.  

▪ Outgoing Email Server Port – Enter the port to use if the outgoing email server 

requires a port other than 25 

▪ Check the box for Use an SSL/TLS connection if your email server requires a secure 

connection. 

 

From Email Account(s) 

Companies often want to use MyAssistant to automate or work with multiple aspects of their 

business. As such, a common request is having MyAssistant send emails from different email 

addresses. With MyAssistant, you can send messages from different Email Addresses. 

 

Enter the following information for each Email Address that you want MyAssistant to use: 

▪ Default Checkbox – This controls which account MyAssistant sends emails from 

when a "From" email address isn't specified on a Task. 

▪ From Name – This name is displayed in the recipient’s inbox 

▪ Email Address  

▪ User Name – Often the email address (Confirm with your email server administrator) 

▪ Password 
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Important: You may need to configure SMTP relays to allow the MyAssistant Server to send 

email messages. Consult your mail server administrator to confirm your settings and/or 

configure your relays. 

 

When configuring the MyAssistant Server, click "Next" when you're ready to proceed to the 

final step. MyAssistant will then test the email settings for every address entered in the grid 

and alert you if there are any errors. 

 

 

Server Options 
This step covers final options that need to be confirmed for the MyAssistant Server 

Configuration. 

 

 
 

Daily Summaries Time 

Tasks that send a list in an email and have no attachments can be compiled into a once-a-

day "Daily Summary" email sent to recipients. This option controls when Daily Summary 

emails are sent each day (if there are any to send). Please note this time should be after all of 

your Tasks have finished running for the day. 

 

Controlling if a Task's information is included in Daily Summary email is determined in the 

Task Options step of each Task's setup. 

  

Send Errors To 

Should an error occur and MyAssistant is able to send an email about it, it will send a 

message to the person specified in this section. Best practice is to send error messages to 

whoever has the MyAssistant Designer.  
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This information can be updated at a later date in the MyAssistant Designer by opening the 

MyAssistant Designer, clicking the "File" menu button, clicking on "Options", and selecting 

"Server Settings" on the left side of the window that opens 

  

Running Tasks and Sending Service Settings 

MyAssistant runs Tasks and sends emails (i.e. Windows Services) on the server. These 

processes are scalable to increase performance, and can auto-correct if they stop working. 

  

MyAssistant’s Windows Services (named “ISDAdminTaskService” and 

“ISDAdminSenderService”) start other processes named “TaskRunner*32”. Each process uses 

30-50Mb of memory when idle. Many variables affect system resources when Tasks run and 

emails are sent, including: 

▪ The available server memory  

▪ Disk drive performance 

▪ Other server demands at the time the MyAssistant Tasks are run or emails are being 

generated. For example, running Tasks at night may allow MyAssistant to use 

additional server resources. 

  

You can perform the following to determine the optimal number of processes: 

▪ Complete the MyAssistant Server Configuration Wizard with the default settings and 

the MyAssistant Workstation installation. 

▪ Activate two MyAssistant Tasks you will regularly use. 

▪ Monitor the server memory usage and disk queue lengths when the Tasks are run 

concurrently.  

▪ Open the MyAssistant Configuration Manager and increase or decrease the number 

or processes based on the results of this test and available server resources. 
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Miscellaneous 

Where Information is Stored in Sage 
This table helps identify where information is stored in Sage based on where it's entered.  

 

Sage Application and Menu Option Where Information is Stored 

AP > Tasks > Print Checks AP Check 

AP > Tasks > Enter Invoices > Bottom Half of Window AP Distribution 

AP > Tasks > Generate Electronic Payments AP Electronic Payment 

AP > Tasks > Enter Invoices > Top Half of Window AP Invoice  

AP > Setup > Vendors AP Vendor 

AR > Tasks > Enter Cash Receipts AR Activity 

AR > Setup > Customers AR Customer 

AR > Tasks > Enter Invoices AR Status 

BL > Tasks > Quick Bill Invoices BL Invoice 

BL > Tasks > Quick Bill Invoices BL Item 

Comes from PR, AP, EQ BL Work in Progress 

BL > Tasks > Contract-Based Invoices BL Worksheet Entry 

CM > Setup > Bank Accounts CM Bank Account 

CN > File > Open Contract CN Contract 

CN > File > Open Contract > Items listed under the 

Contract 
CN Contract Item 

EQ > Setup > Equipment EQ Equipment 

EQ > Tasks > Enter Costs / Enter Revenues EQ Transaction 

GL > Setup > Accounts GL Account 

GL > Setup > Prefix/Base GL Account Prefix A 

GL > Tasks > Record Entries; GL > Tasks > Change 

Entries 
GL Transaction 

JC > Setup > Category JC Category 

JC > Tasks > Change Orders JC Change Order 

JC > Tasks > Commitments JC Commitment 

JC > Tasks > Commitments > Grid JC Commitment Item 

JC > Setup > Cost Codes JC Cost Code 

JC > Setup > Jobs JC Job 

JC Transactions created when entering costs, 

processing Payroll and AP; etc. 
JC Transaction 

PR > Tasks > Enter Checks; PR > Tasks > Print Checks PR Check 

PR > Setup > Employees PR Employee 

PR > Setup > Employees > Deduction PR Employee Deduction 

PR > Setup > Employees > Pay PR Employee Pay 

PR > Tasks > Enter Time PR Time 

PJ > Contract Control > Change Orders PJ Change Order 

PJ > Contract Control > Change Requests PJ Change Request 

PJ > Contract Control > Commitment COs PJ Commitment Change Order 
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PJ > Setup > Jobs PJ Job 

PJ > Documents > RFI PJ RFI 

PJ > Documents > Submittal PJ Submittal 

PM > Tasks > Manage Lease PM Lease 

PM > Setup > Properties PM Property 

PM > Setup > Tenants PM Tenant 

SM > View > Invoices SM Invoice 

SM > View > Invoices SM Invoice Items 

SM > View > Work Orders SM Work Order 

SM > View > Work Orders > Open a Work Order > 

Register 
SM Work Order Item 

 

 

MyAssistant Formulas 
Sometimes on a Task you may want to see something like: 

▪ A sum (for example: the sum of open AP Invoices for a Vendor) 

▪ Math equations or date math (for example: a Job's remaining budget by subtracting 

Job-to-Date cost from the Total Estimate)  

▪ Looking up information not directly related to what is being found by a Task (for 

example: see the last time a Job was billed by looking at JC Transactions) 

▪ ....and more 

These can all be done with what are called MyAssistant Formulas. MyAssistant Formulas are 

advanced ways to look up, calculate or summarize information in Sage in order to use it in a 

Task. Formulas can be used in several places throughout Task Setup, including (but not 

limited to): 

▪ On a line in a Condition to filter what information is found by Task 

▪ In the prompt field of an attached report that will change its contents 

▪ In an email subject line or message body to provide additional information 

 

Using MyAssistant Formulas in Conditions 

Using MyAssistant formulas in a Task Condition lets you use filter what's found by a 

MyAssistant Task in a way you may not have previously known was possible/how to do it. 

Examples of formulas you can use in a Task Condition include: 

▪ Sum of open AR Invoices for a Customer 

▪ Percent a Cost Code is over-budget 

▪ Last time a Job had overtime 

▪ Number of different Jobs on a Contract 
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▪ Sum of all cost transactions from this month for a Job 

▪ Open amount on an AP Invoice 

Using a MyAssistant Formula in a Condition criteria lets you use potentially more complex 

criteria on a single line to find the Sage information you want. 

 

Add a Formula to a Condition 

When building a Condition in Task Setup, you can add a Formula to a row by clicking the 

Sage field or formula on the left side of the row. Next, expand the "Formulas (Built-In)" or 

"Formulas (Owner)" group (depending on who created the formula) and select the formula 

to use in the row: 

 

After selecting the formula to use, select the appropriate operand and Sage field or 

number/text to check against 
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Creating your own MyAssistant Formula 

To create your own formula to use on a Condition, click "Add Formula" in the button bar: 

 

Select if you want the Formula to give you a number, text or a date; name the formula and 

create your criteria. When finished, click "Save" and close the window. 

 

Important: When you create a MyAssistant Formula, it will be linked to whatever 

information the Task is looking up. For example: if you create a new Formula on a Task that 

is sending a list of JC Jobs, the Formula will be linked to the JC Job record in Sage. This 

means you will only be able to use this Formula on Tasks that can access JC Jobs. 
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How to Be Notified of New Information 
MyAssistant Tasks can be set up to only send someone an email when new information has 

been entered in Sage. Examples include being notified when a new Job, Vendor, Employee, 

Customer, Subcontract, Purchase Order or Invoice has been entered in Sage. This is done by 

comparing what was found the last time the Task ran to the most recent time the Task ran. If 

any new items not previously sent in an email were found, those new items are sent to the 

recipients. 

 

The following steps outline how to set up a Task to send a list of new items entered in Sage: 

 

1. Create a new Task: Click the "New" button in the main MyAssistant window to create 

a new Task 

 

2. Pick what what new items to check for: Choose to send a list in the "What to Send" 

step, then pick what new items MyAssistant should check for (for example: new Jobs). 

 

3. Choose which items to send: Use a prebuilt or create a new Condition in the "What 

to Send" step (for example: JC In-progress Jobs). The Condition will find all items in 

Sage, but settings in later steps will only send the new ones to recipients. 

 

4. Set criteria of which items to send: Create or customize the Condition in the 

"Condition" step to ensure MyAssistant is looking for the right information 

 

Important: It is encouraged that the Condition be as simple as possible (for example: Job 

Number is not blank) to ensure that no new information is unintentionally excluded from 

emails sent by the Task. Again, the Task Condition will initially find all items -- not just the 

new ones. This is expected. 

 

5. Schedule how often to check for new items: Specify if the Task should run on a 

Schedule in the "Schedule" step. 

 

Note: Because the Task (when finished) will only send emails when new information has 

been entered, it can be ran on a more frequent basis than how often emails should be 

received. For example, a Task could be run multiple times a day every day of the week, but 

emails will only be sent when there's new information. 

 

6. Create the list: Select the list's columns by adding Sage fields to the table at the 

bottom of the "Email" step 

 

7. Choose who to email: Specify the recipients that should be emailed when new 

information is entered in Sage. 
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Note: MyAssistant individually tracks the recipients on a Task that sends only new 

information. If a new recipient is added after the Task has been previously run, it is 

recommended that the Task is run (but doesn't send emails) as outlined in the Prime the 

Queue step below. 

 

8. Turn on "Notify Once": Click the "Notification Frequency" field at the top of the 

"Options" step and select "Once". This controls how often each recipient is emailed 

about each item (for example: Job) found by the Task. Click "Finish" to close Task 

Setup after naming the Task 

 

9. Prime the Queue: Click "No" when prompted to run the Task and send Notifications 

after finishing Task Setup (the Task will still be activated). Next, select the Task in the 

main MyAssistant window and click "Run" in the ribbon. Running the Task but not 

sending any emails will identify all the information (for example: Jobs) currently in the 

Sage software, and mark them as sent to each recipient despite no message(s) being 

sent. This ensures that recipients will only be emailed when new information is 

entered in Sage. 

 

 

 

How to Be Notified When Information Changes 
MyAssistant Tasks can be set up to only send emails when information in a field in Sage has 

changed. It works by tracking the value(s) in the Sage field(s) you select every time the Task 

runs. If any of the tracked fields have a different value than the last time the Task ran, the 

recipients are sent an email of the change, including the old and current values for the 

field(s). Examples of using "Notify on Change" include being notified when contact 

information on a Job or Vendor has changed; or when an Employee's pay rate has changed. 

 

The following steps outline how to set up a Task to send a list of information that has 

changed in Sage: 

 

1. Create a new Task: Click the "New" button in the main MyAssistant window to create 

a new Task 

 

2. Pick what what information to monitor check for: Choose to send a list in the 

"What to Send" step, then pick what Sage records MyAssistant should track for 

changes (for example: PR Employee Pays in order to monitor rates). 

 

3. Choose which items to send: Use a prebuilt or create a new Condition in the "What 

to Send" step (for example: PR Employees currently employed). The Condition will 

find all items in Sage, but settings in later steps will only send emails when something 

has changed. 

 



Copyright © 2023 Innovative Software Design 143 

 

4. Set criteria of which items to send: Create or customize the Condition in the 

"Condition" step to ensure MyAssistant is looking for the right information  

Important: It is encouraged that the Condition be as simple as possible (for example: 

Employee ID is not blank) to ensure that no information is unintentionally excluded from 

emails sent by the Task. Again, the Task Condition will initially find all items -- not just what's 

changed. This is expected. 

 

5. Schedule how often to check for changes: Specify if the Task should run on a 

Schedule in the "Schedule" step. 

 

Note: Because the Task (when finished) will only send emails when information in Sage has 

changed, it can be ran on a more frequent basis than how often emails should be received. 

For example, a Task could be run multiple times a day every day of the week, but emails will 

only be sent when an Employee's Pay Rate changes. 

 

6. Create the list: Select the list's columns by adding Sage fields to the table at the 

bottom of the "Email" step 

 

7. Select the fields to monitor: Right-click on the column heading in the Notification 

List and select "Notify on Change" for the fields that should be monitored (for 

example: the "Rate" field off the PR Employee Pay record). Repeat for any other fields 

in the Notification List that should be monitored for changes. 

 

8. Choose who to email: Specify the recipients that should be emailed when 

information changes in Sage. 

 

9. Close the Task: Name the MyAssistant Task and click  "Finish" in the bottom-right to 

close Task Setup. 

 

10. Prime the Queue: Click "No" when prompted to run the Task and send Notifications 

after finishing Task Setup (the Task will still be activated). Next, select the Task in the 

main MyAssistant window and click "Run" in the ribbon. Running the Task but not 

sending any emails will identify all the information (for example: Employee Pay Rates) 

currently in the Sage, and the values for the fields being monitored. If the Task were 

to be run again, the number of Notifications would be zero (because no information 

in Sage changed between Task runs). This ensures going forward that recipients will 

only be emailed when information has changed in Sage. 
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Manage Unsent Emails 
After a Task runs, MyAssistant starts creating and sending any emails that need to be sent. 

Before emails are handed off to the mail server, the Manage Unsent Emails feature allows 

for tracking and potentially stopping emails from sending. 

  

To open, click “Manage Unsent Emails” in the ribbon of the main MyAssistant window: 

 
 

The window that opens will list all recipients scheduled to receive emails (including Cc'd and 

Bcc'd recipients), grouped by Task. At the bottom of the window is a count of recipients 

across all Tasks that have emails in queue. 

 

The window also contains the following buttons: 

 

Refresh: Updates the list of recipients scheduled to receive emails. Any recipients whose 

emails have been sent since the window was opened/since the last time the "Refresh" button 

was clicked will be removed from the list. 

 

Don't Send: Removes from queue the emails for any recipients or Tasks selected 

 

Don't Send and Delete: Removes from queue the emails for any recipients or Tasks 

selected, and deletes the Notifications from the Task(s) associated with those recipients' 

emails 

 

Select All: Selects all recipients listed across all Tasks 

 

Deselect All: Unchecks the checkboxes for all recipients listed across all Tasks  

 

To stop an email in queue: 

1. Click "Manage Unsent Emails" in the button bar in the main MyAssistant window 

2. Select the recipient(s) whose emails should not be sent. This could be: 

a. All recipients across all Tasks with emails in queue (done by clicking "Select All") 

b. All recipients for a single Task (done by clicking the checkbox for the Task) 

c. One or more recipients on one or more Tasks (done by expanding each Task and 

clicking the checkbox for each recipient) 

3. Stop the emails from sending and/or delete the associated Notifications 

a. Clicking "Don't Send" will stop the emails 

b. Clicking "Don't Send and Delete" will stop the emails and delete the Notifications  
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See What Each Recipient Will Receive 
Many companies want to be able to review what will be sent from MyAssistant before it goes 

out, especially when sending each person their reports or documents. Common examples 

include reviewing weekly pay stubs before they're sent to Employees, or looking at monthly 

rent bills before they're sent to Tenants. To review what each recipient will receive before 

sending it to them, perform the following: 

 

Determine if the Task is using "Send Once Per" 

The number of steps to review what each recipient would receive from a MyAssistant Task 

changes depending on whether or not the Task is already using the Send Once Per 

functionality. To check: 

1. Select the desired MyAssistant Task in the main MyAssistant window and click "Open" 

in the ribbon 

2. Click "Task Options" on the left side of the window that opens 

3. Check the field next to the line "Separate email for each" 

a. If the field says "Select...", then "Send Once Per" is not being used 

b. If the field shows anything besides the word "Select...", then "Send Once Per" 

is being used 

 

If the Task is using "Send Once Per" 

1. Click "Email" on the left side of the Task Setup window 

2. Remove any Email Directories or typed email addresses from the recipient lines 

(To/Cc/Bcc) 

3. Type the email address of the person who will review the emails in the To line 

4. Click and drag the field being used in the "Separate Email for Each" section from the 

list in the bottom-right to the Subject line (if not there already). This will help 

differentiate the emails when they're received. 

5. Click "OK" to close the Task Setup window 

6. Click "Run and Send" in the ribbon of the main MyAssistant window to run the Task 

7. Review the emails and their contents when delivered 
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If the Task is not using "Send Once Per" 

1. Click Email on the left side of the Task Setup window 

2. Identify any Email Directories used on the Task (indicated by bracketed text in the 

recipient lines; like "[PR Employee]") 

3. Click "Email Directory" in the ribbon 

4. Click "Setup Email Directories" at the bottom of the window that opens 

 

5. Select the Email Directory being used on the Task in the window that opens and click 

"Change" 

6. Click "Next" on the first step of the window that opens 

7. Note the values in the "Sage 300 CRE database record" and "Sage 300 CRE database 

field" at the top of the window 

8. Click the X in the top-right to exit and not save any changes 

9. Click "Close" to close the "Define Email Directories" window   

10. Click "Cancel" to close the "Select Email Directories" window 

11. Remove any Email Directories or typed email addresses from the recipient lines 

(To/Cc/Bcc) 

12. Type the email address of the person who will review the emails in the To line 

13. Click and drag the "Sage 300 CRE database field" from the "Sage 300 CRE database 

record" grouping from the list in the bottom-right to the Subject line (if not there 

already). This will help differentiate the emails when they're received. 

14. Click "Task Options" on the left side of the Task Setup window 
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15. Click the dropdown next to "Separate Email for Each" 

16. Choose the field that was listed in the "Sage 300 CRE database field" from the "Sage 

300 CRE database record" grouping in the list 

17. Click "OK" to close the Task Setup window 

18. Click "Run and Send" in the ribbon of the main MyAssistant window to run the Task 

19. Review the emails and their contents when delivered 

 

Revert a Task After Review 

1. To change a Task back after reviewing the emails and determining they're ready to 

send, perform the following: 

2. Select the desired MyAssistant Task in the main MyAssistant window and click "Open" 

in the ribbon 

3. Click "Email" on the left side of the window that opens 

4. Remove the email address of the person who reviewed the emails 

5. Re-add the recipients to the Task 

a. Use the Email Directory button in the ribbon to re-add any Email Directories 

on the Task 

6. If "Send Once Per" was not  being used on the Task 

a. Click "Task Options" on the left side of the window 

b. Click the eraser icon on the far-right of the "Separate Email for Each" line 

7. Click OK to close Task Setup 
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Troubleshooting 

System Log 
If an error occurs or if something may not be working correctly, consult the System Log that 

identifies and explains (in non-technical terms) what, if anything, happened. View the System 

Log by opening the MyAssistant Designer, clicking "File" and selecting "System Log". 

 

 
 

When the log opens, events will be sorted with the most recent at the top. In most cases, the 

common issues can be resolved with the step-by-step instructions provided.  

 

If someone else needs to review the log, export a copy by clicking the "Export Log" button in 

the ribbon. 
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Reports 
In some cases, an attached report sent by a MyAssistant Task may fail to run, or will run but 

not contain the correct information.  

 

This section outlines some possible steps to check if a report is working correctly. 

 

Report runs, but wrong information 

If a report is not producing the information expected, try the following: 

1. Select the Task sending the report in the main MyAssistant window & click "Open" 

2. Go to the Data Folders step (if available) and confirm the Task is set to run for the 

correct data folder 

3. Go to the Email Step 

4. Right-click on each report in the Attachments section (under the Subject line) and 

select "Report Options" 

5. Confirm the prompts (if there) are filled out correctly to create a report or document 

with the desired information. This can be achieved by adding the report to the Sage 

Reports menu and running the report with the same prompts that are being passed 

in by MyAssistant. 

 

Report does not run/email isn't received 

If an email with an attached report isn't received or if an error stating that an attached report 

didn't complete is received, try running the report in Sage on the server using the steps 

below. This can help identify why the report wasn't created and/or sent.  

 

1. Click the to "File" menu button, click "Options" and select "Server Settings" in the 

MyAssistant Designer to find the Sage user & password MyAssistant is using to 

access Sage 300 information on the server 

2. Identify the computer where the MyAssistant Server software is installed. This is the 

computer from which MyAssistant sends emails and creates attached reports.  

a. If unsure about which computer has the MyAssistant Server software, look up 

the server named (just after the “\\”) at the beginning of the Sage data folder 

path when opening a Sage application and choosing a data folder 

3. Log on to the server identified in step 2 using Remote Desktop Connection or a 

similar program (depending on environment). If using Remote Desktop Connection, 

enter a Windows user & password with sufficient permissions to log on to the server. 

 

Note: Depending on security settings, an administrator-level user may be required to log on 

to the server. Consult with IT for assistance. 

 

4. Check MyAssistant's Windows Service responsible for creating & sending emails and 

reports: 
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a. Click the Windows Start button and type "Services" 

b. Select "Services" from the results 

c. Scroll down to "ISDAdminSenderService" and check the "Log on as" column  

i. If the service is set to "Log on as" an account called "Local System", 

update the service to run as the Windows user you used to log on to 

the computer 

ii. If it's set to "Log on as" a Windows user other than "Local System", log 

off of the server and log back on as that Windows user (if not logged 

in as them already) 

5. Log into Sage Desktop using the Sage user & password found in Step 1 

6. Open the application that has the (first) report on the Reports menu 

7. Run the report from the Sage menu 

a. If the (first) report attached to the Task is not on the Sage Reports menu, add 

it 

b. Run the report from the menu with the same values being used in the report 

prompts in MyAssistant 

8. If the report fails, work with whoever designed the report to update it 

a. If the report works when running it from the Sage menu, remove the report 

from the MyAssistant Task and re-attach it using the Sage Report button in 

the Email step of Task Setup 

9. Repeat for each report on the Task 

10. Re-run Task after all reports have been updated 

11. If the Task still does not work, consult the System Log or consider contacting your 

local consultant or Sage Support 
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Can't Find Information on a Task 
When creating or modifying a Task, sometimes not all of the desired information is 

accessible or easily found. The most common causes are: 

 

Custom Fields & Descriptions not imported 

When field descriptions are changed or custom fields are created in Sage, MyAssistant needs 

to be made aware of the changes. To do so, the "Import Sage Customizations" process must 

be run: 

1. Open the MyAssistant Designer 

2. Click "File" and select "Options" 

3. Click "Server Settings" on the left side of the window that opens 

4. Click "Import Sage Database Customizations" near the top-right of the window 

5. If MyAssistant is monitoring multiple Sage data folders, select which data folder's 

custom fields and descriptions will be imported. If MyAssistant is monitoring one 

Sage data folder, this step will be skipped. 

Note: Only one Sage folder’s custom fields & descriptions can be in MyAssistant at a time. 

Importing another Sage data folder’s customizations will overwrite previous Sage 

customizations in MyAssistant. 

6. Click "OK" in the bottom-right to close the window once the import is complete 

7. Click "File" and select "Restart Run and Send" 

8. Click "OK" on the message that appears 

9. Close and reopen MyAssistant -- the information should now be accessible 

 

Information Not Accessible (Data Relationships) 

When creating a MyAssistant Task, one of the first steps is to identify what the Task will send 

a list of, a spreadsheet of, or what Sage record the Task will use to create a mailing list. The 

Sage record selected becomes what's called the "Driving Record". After a "Driving Record" 

has been selected, MyAssistant automatically filters available information on the Task to 

Sage records that have a "one-to one relationship" with the Driving Record.  

 

A "one-to-one" relationship means that one item exists in the other Sage record for each 

one of the items in the Driving Record. For example, every JC Cost Code is tied to one JC Job. 

This means that if a Task has a Driving Record of "JC Cost Code", information on the JC Job 

record can be added/used on the Task. This means there is a one-to-one relationship going 

from the JC Cost Code to the JC Job. 

 

However, the inverse is not true: one JC Job could have multiple Cost Codes, so there is a 

"one-to-many" relationship going from the JC Job to the JC Cost Code. This is why the JC 

Cost Code record is not available when a Task's Driving Record is JC Job. 
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Depending on the Task and the information that needs to be accessed, there are two 

possible solutions to this issue: 

1. Create a new Task with a new Driving Record: The Driving Record on a Task 

cannot be changed once a Task has been activated. Instead, create a new Task with a 

different driving record that can access all desired information 

 

2. Create a MyAssistant Formula: Depending on the information being looked up, 

another potential solution is to create a MyAssistant Formula. This is a viable option 

when a one-to-one relationship between records does not exist, but only one piece 

of information needs to be looked up (for example: looking up the Project Manager 

name on the PJ Job Contacts List when the driving record in PJ Job). 

 

 

Glossary 
MyAssistant Task: Individual processes in Sage MyAssistant that look up information based 

on selected criteria, then send emails based on what’s found. 

  

Condition: The part of a MyAssistant Task that determines what is being looking up in Sage, 

as well as the criteria that information has to meet. Similar to the “Conditions” button found 

on Sage reports and Sage Inquiries. 

  

Driving Record: Set in the "What to Send" step, the Driving Record is what a Task will send a 

list of, a spreadsheet of, or what Sage record the Task will use to create a mailing list. The 

Driving Record also controls what other Sage information can be accessed to include in the 

Condition, the Email Step, or which Email Directories can be used on a Task. 

  

Operand: Part of each line of a Condition that controls how the value in a Sage field or 

MyAssistant Formula will be compared to a specified value, or the value in another Sage field 

or MyAssistant Formula. 

 

Email Directory: A way to look up email addresses entered in Sage and associate them with 

related Sage information. Email Directories are used on Tasks to send each recipient only 

their information.  

 

Spreadsheet Template: Attached to a Task to define the content and layout of spreadsheets 

generated and sent attached to an email. Spreadsheet templates must be used on Tasks 

because the number of items that need to be included in a spreadsheet may change each 

time a Task is run. 

 

Notifications: The all-encompassing term for items found by a Task when successfully ran. 

For example: one Task may run and find 20 JC Jobs that met its criteria, while another Task 

ran and found 20 AP Invoices that met its criteria. In this case, each Task has 20 notifications. 
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